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Basic Concepts
A GammaCAD drawing is composed of different drawing elements.    Drawing elements are 
lines, arcs, circles, points, text, symbols, polylines and filled areas.    To create one of these 
drawing elements, you select it from the Draw menu or select its icon from the command tool 
bar.    You must then specify where the drawing element is to be placed in the drawing area.    See
the Parts of the Program Window section to locate the drawing area, command tool bar and other
parts of the GammaCAD window.    When specifying where a drawing element is to be located, 
you use drawing coordinates.    See the Drawing Coordinate System section for more 
information.    For a description of the different ways in which you can specify these coordinates 
within GammaCAD, see the section on Specifying Positions .



Getting Started
If you are not familiar with Windows, you should go through the "Getting Started" section of 
your Windows manual first.    There is also an online tutorial in the Main group of Program 
Manager.    Double click on the Windows Tutorial icon to run it.    If you are not familiar with 
how to use this help facility, select the How To Use Help option on the Help menu above.

If you have never used a CAD program, you should go through the tutorials first.    Run the 
GammaCAD program and select the Help menu.    Click on the Tutorials option and go through 
each tutorial in order.    These tutorials will teach you the basics of how to use the program.

If you are familiar with CAD and Windows, you can probably jump right in and start using the 
program and use the Command Reference section, as needed, to learn about specific commands.

If you are upgrading from a previous version of this program, you will probably want to start 
with the section, What's New in this Release.

See also:
Help Menu



Creating Drawing Elements
The commands on the Draw menu are used to create elements in your drawing.    The following 
drawing elements can be created in GammaCAD:
Lines
Arcs
Circles
Points
Text
Symbols
Dimensioning
Polylines
Rectangles
Fill / Hatch

Stop



Using Element Snaps
Element snaps allow you to specify a position in the drawing area when a command prompts you
to enter a point.    This method allows you to specify positions based on elements already in the 
drawing.    For example, if you want a line to start at the exact same position as the end of 
another line in your drawing, you would use the End element snap.    To use element snaps, 
simply choose the desired mode using the Snaps pull down menu.

The Snaps pull down menu or the snaps tool bar is used to set the current snap mode.    That 
mode remains in effect until another is set.    The current snap mode is denoted on the snaps 
menu by a check mark (None in the figure below)

Snaps Menu

and it is denoted by the depressed button on the snap tool bar (NONE below).

Snaps Tool Bar

When the program is not prompting you for a point, the cursor is the standard Windows arrow 
cursor.    If the current snap mode is None or Grid and the program is prompting you for a point, 
the cursor is a plus ( ) in the drawing area.    Otherwise, the program will display a box cursor (

) when it is prompting you for a point.

You can choose an element snap before or during a command.    When a position is selected and 
a snap mode other than None or Grid is set, the program will look to see if an element is within 
the cursor box.    If one is, the program will determine the proper coordinates to use for the point 
from this element using the current snap mode.    The program tries to snap to the first element it 
finds within the box.    If it cannot snap to this element it uses the center of the box as the input 
point.    When you are using element snaps, you should make sure only one element lies within 
the cursor box, so you are certain you are snapping to the proper element.    Use the Zoom 



Window command to enlarge the area around the element you are snapping to, if necessary, to 
avoid getting other elements in your cursor box.

For example, if the box cursor is placed as in the figure below and the current snap mode is set to
End, the program will use the coordinates of the closest end of the line as input.

Element Snap Pick

In this case the program snapped to the top of the line and that point is used as the start of a new 
line as shown below.

Element Snap Result

The Grid snap mode is different than the other modes in that it does not snap to an element in the
drawing.    When the program is in grid snap mode and you pick a point using the mouse, the 
program will snap to the closest grid point and use that for the coordinates of the point you are 
inputting.    The program will snap to the nearest grid point even if the grid is not currently 
displayed.    Use the Options/Grid snap parameters command to turn the display of the grid on 
and off and control the spacing of the grid points.

The element snaps which are available within this program are:

 None no element snaps are used.

 Grid snap to the closest grid point.

 Midpoint snap the the middle of a line or arc.

 End snap to the center of an arc or circle.

 Point snap to the position of a point element.



 Nearest snap to the closest position on a line, arc or circle.

 Intersection snap to the intersection of two lines or a line and an arc or circle.

 Tangent snap to the tangent point on an arc or circle from the last point entered.

 Perpendicular snap to the perpendicular point on a line, arc or circle from the last point 
entered.

The table below summarizes which element snap modes can be used for each drawing element.    
If an element does not support a particular snap mode, there is no X in the column for the 
element.    If you try to snap to an element using a nonsupported snap mode, no snap position is 
determined and the position of the center of the cursor box is used.

Line Arc Circle Point Text Insert Pline Fill
Grid x x x x x x x x
Midpoint x x x
End x x x
Center x x
Point x
Nearest x x x x
Intersection x x x
Tangent x x
Perpendicular x x x x

Element Snaps

See also:
Specifying Positions



Setting Drawing Properties
The following properties are stored in every drawing.    When a new drawing is created, these 
properties are set to a default value.    You can modify this default value by creating a prototype 
drawing.    See the section on creating a prototype drawing for more information.

Line Properties
Text Properties
Point Properties
Fill / Hatch Properties
Dimension Properties
Layers
Drawing Base Point
Grid Snap Parameters
Number Format
Display Page
Display DXF Elements

The color, type and size buttons are short cuts for setting the color, type and size for the current 
drawing command.    For example, if you choose the Draw/Line command and click on the color 
button , the color dialog will be displayed and you can enter the color for the next line.    See 
the following sections for more information.

Color Button 
Type Button 
Size Button 



File Operations
Saving the Drawing
Opening an Existing Drawing
Creating a New Drawing

Exiting the Program



Using DXF Files
Drawing Interchange Files (DXF) are used to transfer graphical information from one program to
another.    This format is defined by Autodesk and is used by AutoCAD to import and export 
drawing information.    GammaCAD can also read (import) and write (export) DXF files.    This 
means you can transfer drawings to GammaCAD from AutoCAD and any other program which 
supports DXF output.    It also means you can transfer drawings from GammaCAD to AutoCAD 
and any other program which supports DXF input.

The GammaCAD DXF transfer is designed to be a loss less transfer.    This means all the 
information in the DXF file is stored in the GammaCAD drawing on import and then written to 
the DXF file on export.    In other words, if you import a DXF file into GammaCAD and then 
immediately export the drawing to a new DXF file, the new DXF file will contain all the 
information present in the original (although not necessarily in the same order).    Not all 
programs which support DXF transfer will preserve your drawing in this manner and the DXF 
import / export process will introduce unwanted changes in your drawing.    For example, a line 
type might be different, a color changed or the z-coordinates lost.

What this means to you is GammaCAD can be used to edit drawings created in another program 
(e.g. AutoCAD) and then imported back into that program without introducing any unwanted 
changes in the drawing.    Of course, any editing you do to the drawing in GammaCAD will be 
present when you import the drawing back into the original program.    This allows you to use 
GammaCAD to supplement a more expensive CAD system.    What this does not mean, is that 
GammaCAD will display the drawing exactly as it was in the original program.    GammaCAD 
does not support all the types of entities and entity properties possible in a DXF file but it does 
preserve them in the GammaCAD drawing.

The GammaCAD DXF transfer is designed for AutoCAD release 11 or later.

See Also:
Importing DXF Files
Exporting DXF Files



Printing / Plotting a Drawing
The File/Print/plot command allows you to make a hard copy of your drawing.    In 
GammaCAD, printing and plotting refer to the same thing, sending the current drawing to a 
Windows print device.    The device may be a printer or a plotter.    Before plotting the drawing, 
you should position the drawing on the printer page.    The File/Page setup commands are used 
for this.    After setting up the page, choose the File/Print/plot command.    This will bring up the 
print dialog which allows you to set certain parameters for this printout.

Print Dialog

Not all printers support all the options in this dialog.    If the printer does not support an option 
then it will be grayed out.    The Print Range will always be set to All since GammaCAD prints 
the drawing to one page only.    It will not divide a drawing into multiple pages if it is too large to
fit on one.    You cannot specify a page range.    Pressing the Setup button brings up the print 
setup dialog.    This dialog allows you to select a printer and set the parameters for that printer.    
Pressing the OK or Cancel button in the print setup dialog returns you to the print dialog.

After the OK button is pressed in the print dialog, another dialog box is displayed.    This dialog 
is displayed while the plot is being created.    This dialog has one button, Cancel.    Pressing this 
button will cause the plot operation to be canceled.    If you want to create a plot, do not click on 
this button or press Enter.    If this button is not pressed, the plot is created and sent to the Print 
Manager.    For more information on the Print Manager see your Windows manual.    Print 
Manager handles the print job from this point on, sending it to the designated printer when it is 
ready.

Print Cancel Dialog



Editing Drawing Elements
Once you have placed drawing elements in the drawing, you can modify them using the 
commands on the Edit pull down menu.    Some of the commands on the Edit menu operate on 
the currently selected drawing elements.    These commands are grouped together on the menu 
with the Select command.    The commands are:

Cut
Copy
Delete
Rotate
Scale
Change
List

If no elements are selected in the drawing, these commands are grayed out and unselectable.    
For more information on selecting elements for these commands see the section on Selecting 
Drawing Elements.

The following edit operations can be performed on the current drawing element selection.
Moving Drawing Elements
Copying Drawing Elements
Moving / Copying Drawing Elements to Another Drawing
Deleting Drawing Elements
Rotating Drawing Elements
Scaling Drawing Elements
Changing Drawing Element Properties
Listing Drawing Element Properties

These edit commands do not require or use the current drawing element selection.
Trimming Lines, Arcs and Circles
Extending Lines and Arcs
Filleting Two Lines
Converting Polylines to Line Segments (so they can be broken, extended and filleted)
Changing Text Strings
Open/Close a Polyline
Modifying Symbols
Modifying the Dimension Arrow Head
Placing Drawings in Documents in Other Programs

After editing a drawing element, you can undo the changes with the Undo command.
Undoing Changes to the Drawing



Changing the View of the Drawing
The view commands are used to display different parts of your drawing.    They can be used to 
look at an area in detail or the drawing as a whole.    They do not change the actual coordinates or
dimensions of the drawing elements.    They only allow you to view them in different ways.

Zooming In on an Area of the Drawing
Displaying the Entire Drawing
Restoring a Previous View
Zooming In and Out
Displaying the Page View
Displaying the Page and Entire Drawing
Moving the Drawing Right, Left, Up and Down (panning)
Redraw



Program Configuration
The Options/Program configuration commands allow you to set certain properties for the 
program as a whole and are not tied to a specific drawing.    In other words, these properties 
remain the same for all drawings.    The program configuration options are:

Selection Set Color
Cursor Increment
Arc/Circle Step Factor
Monochrome Print/Plot
Grid Dot Size
Grid Density

If you make changes to these options, they are stored in the file GAMMACAD.INI in your 
WINDOWS directory.    Initially, the program uses default parameters for these options and does 
not use this file.    To return to the default settings for these options, you can delete the 
appropriate line in the GAMMACAD.INI file.



Command Reference
Move the cursor over the desired menu item and click the left mouse button or select the menu 
from the list below.

File
Edit
Draw
View
Snaps
Options
Help



Dimension Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Leader
Vertical
Horizontal
Parallel
Radial



Using the Keyboard
Quick keys can be used as a short-cut instead of choosing the corresponding commands off of 
the menu.    The table below summarizes the quick keys which can be used in this program and 
what they do.    These are also referred to as keyboard accelerators or accelerator keys.

Key Description
Ctrl+S Save the drawing to the current file.
Ctrl+Z Undo the last edit operation or draw operation.
Ctrl+E Select drawing elements.
Ctrl+X Cut the current selection to the clipboard.
Ctrl+C Copy the current selection to the clipboard.
Ctrl+V Paste the contents of the clipboard.
Delete Delete the current selection
Ctrl+H Change properties of the current selection.
Ctrl+L Draw a line.
Ctrl+A Draw an arc.
Ctrl+I Draw a circle.
Ctrl+P Draw a point.
Ctrl+T Draw a text string.
Ctrl+O Load symbol library.
Ctrl+W Zoom window.
Ctrl+R Zoom previous.
F2 Brings up the coordinate input dialog when the program is prompting for a 
position.
F1 Brings up the Windows help facility and moves to the section on the current 
command (if any).
Esc End the current command.
+ Set/unset Add selection mode.
- Set/unset Remove selection mode.

To choose a command from the menu, press the Alt key and the underlined character of the main 
menu containing the command (e.g. Alt+F for the File menu).    Then press the underlined 
character of the desired command or highlight the command using the up and down arrow keys 
and press Enter.

Key Description
Alt+F Pulls down the file menu.
Alt+E Pulls down the edit menu.
Alt+D Pulls down the draw menu.
Alt+V Pulls down the view menu
Alt+S Pulls down the snaps menu
Alt+O Pulls down the options menu
Alt+H Pulls down the help menu

The arrow keys can be used to move the cursor around in the drawing area and the Enter key to 
select a point.



The following keys can be used in dialogs.

Key Description
Tab Move to the next field.
Shift+Tab Move to the previous field.
Space Bar To select a radio button or check box.
Enter To press the highlighted button.

Other sections in this document describe any special key input required for a particular command
or operation.    See your Windows manual for more information on Windows keyboard input.



Glossary
Accelerator Key A short-cut key sequence which can be used instead of choosing a 

command from a menu.
CAD Computer Aided Design.
Command Any of the selections available on the pull down menu or iconic tool 

bars.
Current Selection All the drawing elements which have been selected using the Select 

commands.
Cursor Increment The number of pixels the cursor moves when a keyboard arrow key is 

pressed.
Cursor Step Same as Cursor Increment.
Dialog Box A Windows pop up menu which contains input fields, check boxes, 

buttons and so on.
Drawing Area Extents The range of coordinates displayed in the drawing area.
Drawing Extents The range of coordinates covered by all the drawing elements.
Drawing Element One of the basic parts of a drawing (e.g. lines, arcs, circles, points, 

text,...).
Drawing Units The dimensions used in the drawing area.    They can be anything (e.g. 

feet,meters,etc.)
Font A particular style of text.
K (Kilobyte) 1024 bytes of memory or disk space.
M (Meg or Megabyte) 1024 K bytes of memory or disk space.
Origin The (0,0) point of an xy coordinate system.
Pan To shift the view of the drawing within the drawing area left, right, up 

or down.
Plot Units The dimensions used to specify sizes on the plot (inches or 

centimeters).
Quick Key A short-cut key sequence which can be used instead of choosing a 

command from a menu.
Raster In this manual, it denotes graphics defined by a series of points as 

opposed to Vector.    For example, a line defined by a series of points.
Selected Elements Same as Current Selection.
Selection Set Same as Current Selection.
Text Angle The rotation, counter-clockwise, of the baseline of a text string.
Text Justification How the text is aligned.    For example, at the left top corner.
Text Orientation The rotation, counter-clockwise, of the individual characters in a text 

string.
Vector In this manual, it denotes graphics defined by their end points as 

opposed to Raster.    For example, a line is defined by 2 points.
Zooming Enlarging or decreasing the view of the drawing.



Select Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

New selection
Select one
Add    
Remove    
Clear



Program Description
GammaCAD is a full featured CAD (Computer Aided Design) program for Windows.    It 
provides a wide range of functionality in an easy to use package.

GammaCAD allows you to create drawings of real world objects in two dimensions using their 
actual measurements.    They can then be plotted at any scale you choose on any of the vast 
number of printers and plotters supported by Windows.    The biggest advantage of using a 
computer to create these drawings over conventional hand methods is the ease with which a 
computer based drawing can be edited and replotted at different scales.

CAD is used in many fields including: architecture, cartography, electronics and engineering.    It
can be used to create house plans, maps of all kinds, printed circuit diagrams, and any kind of 
graph, chart, diagram or illustration.

This program allows you to create drawings using the following drawing elements: lines, arcs, 
circles, points, polylines, rectangles, filled and hatched areas .    You may enter exact coordinates 
for these elements, pick a position on the display or snap to a position on another element in the 
drawing.    For example, you can draw a line which starts exactly at the end of an existing line.    
GammaCAD also has predefined symbols you can place in your drawing for such things as floor 
plans, furniture, polygons, electronics, landscaping, computer equipment and civil engineering.    
The program also allows you to place dimensions on your finished drawing.

Once you have placed elements in your drawing, you can edit them to your liking.    They can be 
edited individually or as a group.    The elements can be deleted, moved, copied, scaled, rotated 
and their properties can be changed.    Certain elements can also be trimmed, extended and 
filleted.    These operations can be undone.    This allows you to experiment with the drawing.

Many properties of the drawing elements can be specified, such as line type (e.g. solid, dashed, 
dotted, etc.), line color and line width. Text properties include: font, size, color, angle and 
justification.    Point type, color and size can also be set.    Drawing elements can also be placed 
on different layers which can be selectively turned on and off.

The drawing can be zoomed and panned to look at different parts in more detail.    Zoom 
functions include: window, extents, previous and factor.

The drawings you create in GammaCAD can be copied to the Windows clipboard as a bitmap 
and pasted into your favorite word processor, paint program, or any program which lets you 
paste a bitmap.    This means you can place technical drawings in your documents.    GammaCAD
also supports DXF input and output which allows you to transfer drawings to an from other CAD
programs.

GammaCAD is designed to be powerful and easy to use.    The program contains on-line 
tutorials, examples, and context-sensitive help, to get you up and running as quickly as possible.  
A prompt area is displayed at the bottom of the window which instructs you how to perform each
command.    A status area displays pertinent program information at a glance.    The program also 
employs easy to use visual dialog boxes.





Getting Help (Technical Support)
See the Getting Started section for information on how to get started with GammaCAD.

If you have a problem with this program and cannot find the answer in the documentation, help 
may be obtained by calling:

(970) 490-2928      voice/fax (start fax immediately after dialing)

or via E-mail at:

CompuServe: 73737,1721
AOL: GammaSoft
Internet: GammaSoft@aol.com
MSN: GammaSoft

or by writing to:

Gamma Software
P.O. Box 8191
Fort Collins, CO 80526
U.S.A.

We also have support areas at the following locations:
WWW: http://execpc.com/~gamma
MSN: "Go to" GammaSoft to visit our support area.

Please describe the problem in sufficient detail so it can be reproduced by us.

We are open 8am-5pm Mountain time (Mon-Fri) excluding holidays.

Support is currently free and unlimited.    We do reserve the right to change these policies in the 
future.



System Requirements
Windows 3.1 or later and a system capable of running it.
Hard disk with at least 3 megabytes of free disk space.
Floppy drive (if installing from floppy disk).
A Windows supported printer, mouse and color display are highly recommended.

Note - this program will NOT work with Windows 3.0 or previous versions of Windows.



Conventions Used in this Document
When two keys need to be pressed simultaneously to perform a given operation they are 
separated by a plus (+).    For example, Shift+Tab means to press the Shift key and hold it down 
while the Tab key is pressed and then releasing both.

When a menu option or other text from the program is mentioned it is italicized.    For example, 
the text File/Open instructs you to select the File pull down menu and then select the Open 
command on that menu.

Values which must be input by the user are enclosed in quotes.    Enter them without the quotes.   
For example, if the manual instructs you to enter "45" in a field within the program, enter the 
number without the quote marks.

The terms print and plot are interchangeable in this documentation.    They both refer to 
outputting a drawing to a Windows print device.    This device may be a printer or a plotter.



What's New in this Release
The following topics cover features which are new or have been modified in this release of the 
program.
Page Setup
DXF Import
Selecting Drawing Elements
Break End
Break Middle
Extend
Fillet
Explode
Change Text
Open/Close a Polyline
Symbol Libraries
Polylines
Rectangles
Filled / Hatched Areas
Zoom Page
Zoom Page and Extents
Element Snaps
Text Height
Fill / Hatch Color
Fill / Hatch Type
Layers
Grid Snap Parameters
Number Formats
Display Page
Display DXF Elements
Program Configuration
Entering Coordinates



Polyline Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Open polyline
Closed polyline



Number Format
To specify how you want numbers displayed and how you want to enter numbers in the drawing, 
use the Options/Number format command.    The following dialog is displayed when you choose 
this command.

Number Format Dialog

For a description of the fields in this dialog, click on the desired field.    For example, for a 
description of the Number Format Type click the mouse anywhere inside the Number Format 
Type box.

When you create a new drawing, it is initially set to use decimal numbers.    The initial values of 
the Decimal Digits field and Decimal Separator field are taken from the settings in the 
international section (intl) of the Windows WIN.INI file.    These parameters can be configured 
using the International option in the Control Panel.    Click on the Change button in the Number 
Format section and set the Decimal Separator and Decimal Digits fields.    The values you set in 
the Control Panel will be used the next time a new drawing is created.

Once a drawing is created, the changes you make in the Control Panel have no affect.    This is 
because the values input in the number format dialog are saved with the drawing and are restored
when you open the drawing.    This means if you have a prototype drawing, it will effectively 
override you Control Panel settings.

Only coordinate values and distances in drawing units are formatted using the format type 
specified in the dialog above.    Scale factors and angles are always displayed in decimal format.   
They must be entered in decimal format as well.    Very large scale factors are displayed in 
scientific format and can be entered that way as well.    Architectural format can never be used 
for scale factors or angles.

See Also:
Entering Decimal Numbers
Entering Scientific Numbers
Entering Architectural Numbers



Parts of the Program Window
The figure below shows the different areas within the program window.    These will be 
referenced throughout this manual.

Main Window

The main or pull down menu contains the program commands.    The command tool bar, directly 
below the main menu, provides a quick way of accessing certain commands.    The prompt area 
displays what the program currently wants you to enter.    The status area displays the current 
cursor xy coordinates and other pertinent program information.    The drawing area is where 
drawing elements are displayed and drawn.    It is the entire area in white in the above figure.    
The snap tool bar provides a quick way of changing the current snap mode.    The snap mode can 
also be set using the Snaps menu.    The page boundary and print area boundary display the 
position of the page based on the current printer and page setup.



Drawing Coordinate System
This program uses a standard 2 dimensional cartesian coordinate system.    This consists of 2 
axes, x and y, which are perpendicular to each other.    The x axis increases to the right and the y 
axis increases upward.

XY Coordinate System

Positions within this coordinate system are specified by giving their x and y distance from the 
origin.    The origin is where the x and y axes intersect at coordinates (0,0).    Coordinates are 
denoted by x and y values in parentheses within this manual (x,y).    For example, (10,20) 
designates a position 10 units to the right (x distance) and 20 units up (y distance) from the 
origin.

Coordinate Example

These coordinates can represent anything.    For example, they can be feet, meters, inches, 
centimeters, miles or kilometers.    They can even be in units other than distance.    For example, 
you may want the x axis to represent years and the y axis to represent sales in a graph.    You 
decide what the units are.    When you create your drawing, simply use those units when entering 
the coordinates for drawing elements.    Within this program these units are referred to as 
drawing units.    Before you print your drawing, you need to specify a plot scale which relates the
drawing units you are using to inches or centimeters on the printer.

There are some limitations on the coordinates you can use in your drawing.    Values larger than 
1e100 (10 to the 100th power) and smaller than -1e100 cannot be used.    Values within the range 
-1e-100 and 1e-100 also cannot be used.    The coordinate system must be isotropic.    This means
distances in the x and y directions are equal.    In other words, a distance of 10 in the x direction 
is the same as a distance of 10 in the y direction.

The drawing area can be thought of as a window which displays a portion of the entire 
coordinate range.    Drawing elements which lie outside the current window are not displayed but
are still part of the drawing.    The drawing area extents are the lower-left and upper-right 
coordinates of the current drawing area.



Drawing Area Extents

The view commands allow you to view different ranges of drawing coordinates in the drawing 
area by zooming in, zooming out, and panning, similar to the view finder of a camera.    These 
commands change the drawing area extents and thus give you a different view of the drawing 
and display a different window onto the entire coordinate range.    The view commands only 
change your view of the drawing.    They do not change the coordinates of the drawing elements. 
You must use the edit commands to change the actual coordinates of drawing elements.

By default, when a new drawing is first loaded, the origin is at the lower-left corner of the page 
boundary.    This can be changed using the page setup commands.

Coordinate System Origin

The drawing extents are the minimum and maximum xy coordinates of all the drawing elements. 
Note, this is different than the drawing area extents which is the extents of the rectangular 
drawing area in the program window.    The drawing area extents are changed using the view 
commands.    The drawing extents are determined by the elements in the drawing and only 
change when you add or edit drawing elements.

Drawing Extents

The X and Y fields of the status area give you the current coordinates of the cursor within the 
drawing area.    The cursor can be moved with the mouse or keyboard arrow keys and the xy 
position in the status area will be updated as it is moved.



Specifying Positions
You need to specify positions (points) for many of the commands in this program.    A position is 
the (x,y) coordinates designating a location in the drawing.

There are three methods for specifying positions within this program:

1. Pick a position in the drawing area using the cursor.
2. Enter exact coordinates.
3. Snap to an existing drawing element.



Coordinate Input Examples
XY Input
This example illustrates how to draw a line from xy coordinates (1,1) to (4,1).    Select the 
Draw/Line command from the menu.    Click your right mouse button or press the F2 key.    This 
will bring up the coordinate input dialog.    Make sure the XY input radio button is chosen on the 
left.    Select the X field and enter "1."    Select the Y field and enter "1."    Press the OK button.    
Click your right mouse button again or press F2.    Enter "4" in the X field and "1" in the Y field 
and press OK.    You have now drawn a horizontal line which starts at (1,1) and ends at (4,1).    If 
you do not see it, you may need to use the view commands to change the view so the line falls 
within the drawing area.    Choose the View/Zoom extents command and then the View/Zoom 
factor command and enter a factor of "0.5".

Polar Input
This example illustrates how to draw a vertical line with length of 4 which starts at the xy 
coordinate (4,1).    Select the Draw/Line command.    Click your right mouse button or press F2.   
Make sure the XY input radio button is chosen to the left.    Select the X field and enter "4."    
Select the Y field and enter "1."    Press the OK button.    Click your right mouse button or press 
F2 again.    Choose the Polar input radio button.    The prompts next to the two fields on the right 
will change to Distance and Angle.    Enter "4" in the Distance field and "90" in the Angle field 
and press OK.    You have now drawn a line which starts at (4,1) and has a length of 4 drawing 
units at an angle of 90 degrees.    Use the view commands, if necessary, to display the line in the 
drawing area.

XY Offset Input
This example illustrates how to draw a horizontal line which starts at (4,4) and extends 4 
drawing units to the left and 0 drawing units up.    Choose the Draw/Line command.    Click your 
right mouse button or press F2.    Make sure the XY input radio button is selected to the left.    
Select the X field and enter "4."    Select the Y field and enter "4."    Press the OK button.    Click 
your right mouse button or press F2 again.    Choose the XY offset input radio button.    The 
prompts next to the two fields on the right will change to DX and DY.    Enter "-4" in the DX field
and "0" in the DY field and press OK.    You have now drawn a line which starts at (4,4) and 
extends left 4 drawing units and 0 drawing units up or down.    Use the view commands, if 
necessary, to display the line in the drawing area.



Lines
Lines are drawn by entering their start and end points.

Line Input

To Draw a line, all you have to do is choose Line from the Draw pull down menu or you can 
press Ctrl+L or press the draw line button  on the tool bar.    The prompt area will display:

Select first end point of line

After entering the first end point, the prompt area changes to:

Select second end point of line

As you move the cursor, a line is drawn from the first point to the current cursor position.    This 
represents the line which would be added to the drawing if the current cursor position is used for 
the second end point.    When the second end point is specified, a line with the designated start 
and end points is added to the drawing.    It is displayed using the current line properties in effect.

The program continues to prompt you for a second point.    If you wish to draw another line 
which starts at the end of the previous one, select the second end point of the new line.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends line input.    You can also end line input by clicking on the stop button  on the 
command tool bar or by pressing the Esc key.

See the section on Specifying Positions for more information on entering the line end points.    
See the section on Line Properties for more information on the different types of lines which can 
be drawn.



Arcs
Arcs are drawn by specifying their start, center and end points.    They are always drawn in a 
counterclockwise direction.

Arc Input

To Draw an arc, all you have to do is choose Arc from the Draw pull down menu or you can 
press Ctrl+A or press the draw arc button  on the tool bar.    The prompt area will display:

Select first end point of arc

After entering the first end point, the prompt area changes to:

Select center point of arc

After entering the center point, the prompt area changes to:

Select second end point of arc

As you move the cursor, an arc is drawn from the first point to the current cursor position around
the given center point in a counterclockwise direction.    This represents the arc which would be 
added to the drawing if the current cursor position is used for the second end point.    When the 
second end point is specified, an arc with the designated start and end points is added to the 
drawing.    It is displayed using the current line properties in effect.

The program continues to prompt you for the first point of an arc.    If you wish to draw another 
arc, you can enter it at this point.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends arc input.    You can also end arc input by clicking on the stop button  on the 
command tool bar or by pressing the Esc key.

Arcs are always drawn in a counterclockwise direction.    This means the order in which you 
input the arc end points determines the interior angle of the arc.    To get the complimentary arc to
a given arc, simply input the end points in reverse order.



Arc Point Entry

See the section on Specifying Positions for more information on entering the arc points.    See the
section on Line Properties for more information on the different types of arcs which can be 
drawn.



Circles
Circles are drawn by specifying their center point and a point anywhere on the circle.

Circle Input

To Draw a circle, all you have to do is choose Circle from the Draw pull down menu or you can 
press Ctrl+I or press the draw circle button  on the tool bar.    The prompt area will display:

Select center point of circle

After entering the center point, the prompt area changes to:

Select point on circle

As you move the cursor, a circle is drawn around the center point and through the current cursor 
position.    This represents the circle which would be added to the drawing if the current cursor 
position were used.    When the point on the circle is specified, a circle with the designated center
and circumference point is added to the drawing.    It is displayed using the current line properties
in effect.

The program continues to prompt you for the center point of the next circle.    If you wish to draw
another circle, you can enter it at this point.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends circle input.    You can also end circle input by clicking on the stop button  on the
command tool bar.

See the section on Specifying Positions for more information on entering the circle points.    See 
the section on Line Properties for more information on the different types of circles which can be
drawn.



Points
Points are drawn by specifying their position.

To Draw a point, all you have to do is choose Point from the Draw pull down menu or you can 
press Ctrl+P.    The prompt area will display:

Select point

When a position is specified, a point is drawn using the current point properties in effect.

The program continues to prompt you for a point position.    If you wish to draw more points you 
can do so at this time.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends point input.    You can also end point input by clicking on the stop button  on the 
command tool bar or by pressing the Esc key.

See the section on Specifying Positions for more information on entering the point positions.    
See the section on Point Properties for more information on the different types of points which 
can be drawn.



Text
Text is drawn by specifying the text alignment point and entering the desired text string.

Text Input (Top-left justification)

To Draw text, all you have to do is choose Text from the Draw pull down menu or you can press 
Ctrl+T or press the draw text button  on the tool bar.    The prompt area will display:

Select text alignment point

When a position is specified, the text string input dialog is displayed.

Text Input Dialog

Enter the desired text and press the OK button.    The text is displayed using the current text 
properties in effect.

The program continues to prompt you for a text alignment position.    If you want to enter more 
text strings, do so at this time.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends text input.    You can also end text input by clicking on the stop button  on the 
command tool bar or by pressing the Esc key.

See the section on Specifying Positions for more information on entering the text alignment 
points.    See the section on Text Properties for more information on the different types of text 
which can be drawn.



Symbols
The Draw/Insert symbol command is used to insert a GammaCAD drawing as a symbol in the 
current drawing.    Any GammaCAD drawing can be placed in another drawing as a symbol.    
The insertion point, angle and scale factor must be specified.    There is no difference between a 
symbol file and any other GammaCAD drawing file.    Symbol files should be given a SYM 
extension instead of GC1.    This will help you separate the files you use as symbols from your 
drawing files.    Also, the Insert symbol and Redefine symbol commands default to listing files 
with a SYM extension.    If you use this extension, the files will be automatically listed for those 
commands.

To create your own symbols, choose the New option from the File menu, and draw the symbol 
like any other drawing.    To set the base point of the symbol, use the Set Base Point command on
the Options menu.    This point will be matched up with the insertion point you select later when 
you insert the symbol in another drawing.    When you save the drawing, make sure you give it a 
SYM extension.    For example, if you are creating a symbol you want to name WHEEL, enter 
WHEEL.SYM as the file name.

When you want to place the symbol in another drawing, choose Insert symbol from the Draw 
pull down menu.    The Open dialog will be displayed and it will list all the symbol files (*.SYM)
in the current directory.    Double-click on the symbol you wish to place in the drawing.    You can
select any drawing file even if you did not give it a SYM extension.    To do this, type in the 
name of the desired file in the file name box.    You can list the drawing files with a GC1 
extension by clicking on the down arrow next to the file types box and choosing Drawing Files 
(*.GC1).

The prompt area will display:

Select symbol insertion point

The base point of the symbol is aligned with the insertion point you enter.

When a position is specified, the rotation angle dialog is displayed.    Enter the desired rotation 
angle for the symbol in degrees counterclockwise and press the OK button.    Enter "0" for no 
rotation.    The scale dialog is displayed next.    Enter any value other than 0.    A value less than 1 
will cause the symbol to be displayed smaller than its actual size (e.g. 0.5 will cause it to be half 
size).    A value greater than 1 will cause the symbol to be larger than its actual size (e.g. 2. will 
cause it to be double size).    A value less than 0 will cause the symbol to be mirrored across x 
and y axes centered at the insertion point.

After the angle and scale have been entered, the program will draw the symbol using the 
parameters you specified.    It then prompts you for the insertion point again.    You can place any 
number of the same symbol in the drawing, each with its own angle and scale.    Choosing 
another operation from the main menu (except those on the Snaps, Options, or Help menu) ends 
symbol input.    You can also end symbol input by clicking on the stop button  on the 
command tool bar or by pressing the Esc key.



See the section on Specifying Positions for more information on entering the symbol insertion 
points.

General Notes About Symbols
When a symbol is inserted into a drawing for the first time, it is read from the file which contains
the drawing elements making up the symbol.    These drawing elements are stored in the drawing 
only once.    They are defined separately from the main drawing and also from other symbols.    
Each symbol is given a name in the current drawing.    The name is the same as the file name 
from which it was read (except the file name extension is removed).    The next time you insert 
the same symbol into the drawing, the program will see it is already defined and it will not reread
the symbol file.    Each insertion of a symbol in the drawing contains only the name of the 
symbol, its position, rotation angle and scale factor.

See the section Modifying Symbols for information on how to change drawing symbols.

See also:
Symbol Libraries



Dimensioning
Vertical, horizontal, parallel and radial dimensions can be created by this program.    You can also
create leaders to annotate your drawing.

Dimension Types

The dimensioning commands use the current text font, so you must set the font you want to use 
for the dimension text before choosing the dimension command.    Use the Options/Text 
properties/Text font command to do this.    You should choose a font which allows baseline 
rotation (e.g. True Type fonts), since vertical and parallel dimension text is rotated.    The 
dimension commands also use the current line properties for the dimension and extension lines.   
Use the Options/Line properties commands to set the desired line settings before creating the 
dimension.    You should also set the desired dimension arrow size and dimension offset before 
dimensioning.

To create a dimension, choose Dimension from the Draw menu.    The dimension type sub menu 
will be displayed, select the type of dimension you want to create.

Leader
Vertical Dimension
Horizontal Dimension
Parallel Dimension
Radial Dimension



Polylines
Polylines are drawn just like regular lines by entering their start and end points.    The only 
difference is that all the line segments making up a polyline are treated as a unit.    When you 
select one segment of the polyline all the segments are selected.    GammaCAD allows you to 
draw two types of polylines: open and closed.    An open polyline starts and ends at two different 
positions.    A closed polyline ends at the same point as it started.

Open/Closed Polylines

If you specifically close a polyline by snapping to the start point when drawing the last segment, 
then the open/close state of the polyline has no effect; the polyline is always closed.    If you are 
drawing a closed polyline and the last point you enter is not the same as the start point, a segment
is automatically drawn from the last point to the start point.

To Draw an open polyline choose the Draw/Polyline/Open polyline command.    To draw a 
closed polyline choose the Draw/Polyline/Closed polyline command.



Rectangles
To Draw a rectangle, all you have to do is choose Rectangle from the Draw pull down menu.    
The prompt area will display:

Select first corner of rectangle

After specifying the first end point, a box is drawn from that point to the current cursor position 
as you move the cursor.    This represents the rectangle which would be added to the drawing if 
the current cursor position was used for the second corner.    The prompt area changes to:

Select second corner of rectangle

When the second corner is specified, a rectangle with the designated corner points is added to the
drawing.    It is displayed using the current line properties in effect.    The rectangle is actually a 
polyline element with four segments.    The program then prompts you for the first corner of the 
next rectangle.    You can add another rectangle to the drawing if you desire.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends rectangle input.    You can also end rectangle input by clicking on the stop button 
on the command tool bar or by pressing the Esc key.

See the section on Specifying Positions for more information on entering the rectangle end 
points.    See the section on Line Properties for more information on the different types of 
rectangles which can be drawn.



Fill / Hatch
To create a solid fill or cross-hatched area, you must first define the boundary of the area with a 
polyline.    Next, choose Fill / Hatch from the Draw pull down menu.    The mouse cursor will 
change to a box and the prompt area will display:

Select a polyline to fill / hatch

Move the box cursor so one segment of the desired polyline passes through it and click the left 
mouse button or press Enter.    The area bounded by the polyline is filled using the current fill / 
hatch properties.    The program continues to prompt you to select a polyline to fill / hatch.    If 
you want to fill / hatch another area you may do so at this point.

Selecting another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends fill / hatch input.    You can also end fill / hatch input by clicking on the stop button

 on the command tool bar or by pressing the Esc key.



Line Width
To specify a line width, choose Options/Line Properties/Line width from the menu.    You can 
also select a line width using the size button on the tool bar .    It is active only after you have 
chosen the line drawing command.    Enter the desired line width.    This value is specified in 
drawing units and its displayed width will vary depending on the current drawing area extents.    
Specifying a width of 0 will cause the line to be drawn as thin as possible (1 pixel wide) no 
matter what the drawing area extents.

Line Width Dialog

One important limitation is only solid lines can have a width of more than one pixel.    If a line 
width is specified the line type will always be solid.

See also:
Line Properties



Line Type
To specify a line type, choose the Options/Line properties/Line type command from the menu.    
You can also select a line type using the type button on the tool bar .    It is active only after 
you have chosen the line drawing command.    To select a line type, click on the desired type (or 
use the arrow keys).    Click on the OK button (or press Enter) to use the selected line type.

Line Type Dialog

Only the solid line type can have a width.    The line width must be 0 to display any line type 
other than solid.

See also:
Line Properties



Set Base Point
The Options/Set base point command allows you to set the base point for any drawing.    After 
choosing this option, the prompt area will display:

Select base point for drawing

The base point of a drawing is initially set to (0,0).    You input this point like any other (see the 
section on specifying positions for more information).

The base point of a drawing is only used if the drawing is used as a symbol.    The base point you 
select will be aligned with the insertion point you specify when the drawing is inserted into 
another drawing as a symbol.    See the Draw/Insert symbol command.



Symbol Libraries
The Draw/Load symbol library command is used to load one of the GammaCAD symbol 
libraries.    You can choose the command from the Draw menu or press the Ctrl+O accelerator 
key.    The symbol library selection dialog is displayed and it lists the symbol libraries (.DLL) in 
the GammaCAD directory.    Choose the desired library by double-clicking on it or click on it 
once and press the OK button.    You can also use the keyboard up and down arrow keys to 
choose the desired library and then press Enter.

Symbol Library Selection Dialog

After selecting the desired library, the symbols in this library are displayed in the next dialog.    
Click on the symbol you want or use the right arrow key to highlight the desired symbol and 
press Enter.

The prompt area will display:

Select symbol insertion point

The base point of the symbol is aligned with the insertion point you enter.    The base point of the 
symbol is denoted by the red dot on the button for the symbol in the symbol dialog.

Entering the rotation angle and scale factor are accomplished the same way as in the Draw/Insert
symbol command.    You can continue to insert additional copies of this symbol by specifying 
their insertion point, rotation and scale factor.

To select another symbol from the symbol library dialog, position the mouse cursor over it and 
click the left mouse button.    To select another symbol using the keyboard, press the Tab key to 
move back to the current library dialog and highlight the desired symbol using the right arrow 
key and press Enter.    You will then be prompted for the insertion point, rotation and scale, as 
before.    To switch to a different symbol library using the mouse you can simply click on it.    
Using the keyboard, choose the Draw/Load symbol library command and select the desired 
symbol library.    If it is already loaded, it will be made the current symbol library.    If it is not 
loaded, it will be loaded and made the current symbol library.

To position the symbol library dialog with the mouse, click the left mouse button on the title bar 
and hold it down.    Drag the dialog to the desired position and release the left mouse button.    To 
position the dialog with the keyboard, first make sure it is the active window (i.e. the caption bar 



is painted the active color).    Press the Tab key to activate it if it is not active.    Next, press the 
Alt key to bring up the system menu and choose Move from the menu.    Now press the arrow 
keys to move the dialog and press Enter when it is in the desired location.

To close a symbol dialog, double click on the system menu button or click on it once and choose 
Close.    Using the keyboard, first activate the symbol dialog and then press the Alt key and select
Close from the menu.    You may also press Alt+F4 to close the dialog while it is active.

When using the keyboard and a symbol dialog is active, you must first press Tab to return to the 
main GammaCAD window before you can use any of the GammaCAD keys.    For example, to 
bring up a GammaCAD menu using an Alt key combination or to use one of the GammaCAD 
accelerator keys you must first press Tab if a symbol dialog is currently active.



Modifying Symbols
The drawing elements making up a symbol are treated as a unit once a symbol is inserted into a 
drawing.    When you select one drawing element in a symbol, the entire symbol is selected.    
This is due to the fact the elements making up a symbol are stored in the drawing only once.    
Each insertion of a symbol only contains the symbol name, position, scale and rotation.

The Change command on the Edit menu has no affect on symbols.    To change a symbol, you 
must load the symbol file into GammaCAD using the File/Open command.    Symbol files are 
exactly the same as other drawing files.    They are given a SYM extension merely as a file 
keeping aid.    From the Open dialog, click on the arrow button to the right of the List Files of 
Type field (or press Alt+T and then the down arrow key).    Choose Symbol File (*.SYM) from the
list.    The dialog will list the symbol files in the current directory.    Select the desired symbol 
from the list.    You may need to change to the GammaCAD directory.

Once the symbol file is loaded, you can use any of the program commands to add, change or 
delete drawing elements.    Choose the Save command from the File menu when you are done 
editing the symbol.    The next time you insert the symbol into a new drawing the new symbol 
will be used.

The changes will not affect drawings created previously containing the symbol unless you use 
the Redefine Symbol command on the Edit menu.    When you choose this option, the Open 
dialog will be displayed.    The symbol files in the current directory are displayed.    Select the file
which you modified and the program will delete the old definition of the symbol and read the 
new definition from the symbol file you selected.

The program will display the message: Cannot find selected figure if the symbol you selected 
does not exist in the drawing.    The symbol name in the drawing is the name of the file it was 
originally inserted from.    If you insert a symbol into a drawing, change the name of the symbol 
file, and then try to redefine it using the new name, the program will not be able to find it.

The Redefine Symbol command cannot be undone so you may want to save your drawing prior to
redefining a symbol, then you can exit without saving the drawing if the command does not have
the desired effect.



Text Font
To specify a font, choose Options/Text properties/Text font from the menu.    You can also select a
text font using the type button on the tool bar .    It is active only after you have selected the 
text drawing command.

The font name is the main property affecting the appearance of a text string.    It determines how 
different characters in the string are drawn.    Windows comes with several built in fonts.    With 
version 3.1 of Windows, True Type fonts were introduced.    It is recommended you use these 
fonts exclusively.    The True Type fonts work much better with this program because they are 
more scalable.    Raster fonts (e.g. Fixedsys) are not as scalable and may not appear at the proper 
size when you zoom in and out in your drawing or when you specify different plot scales.    There
are also a couple of drawbacks to using the vector fonts which are not True Type.    One is the 
Zoom Extents command only uses the alignment point of vector fonts in its calculations.    This 
means part or all of a text string which uses a vector font may lay outside the drawing area even 
after a Zoom Extents command.    The second drawback is the alignment point must be included 
in your selection area in order to select a string using a vector font which is not True Type.

When you choose the Text font command the following dialog is displayed.

Font Dialog

To choose the font name, click on the desired font name from the list.    You can scroll the list up 
and down by clicking on the scroll arrows if the list is longer than the number displayed.    To 
select a font style, click on the desired style.    The font size, effects and color can be specified in 
the same way.    A sample of the currently chosen font is displayed in the lower right of the 
dialog.    When you have input the desired text properties, click on the OK button.

The parameters in this dialog are pretty self-explanatory with the possible exception of the Size 
parameter.    These sizes are in points.    A point is 1/72 of an inch.    This specifies the size of the 
text when plotted.    The size which appears on the display will vary depending on the currently 
specified plot scale and the current drawing area extents.    When you specify a text size, it is 
converted to the units you are using in the drawing area using the currently specified plot scale.    
The next time text is drawn, it will be drawn at that size.

For example, if you specified a 10 point font and your current plot scale is 1 inch equals 100 
drawing units then the height, in drawing units, for the text would be 13.9 (10 X 1/72 X 100).    If



the y extent of the drawing area is 100, the text will be 13.9% as tall as the y extent of the 
drawing area.    If the drawing is zoomed in so the y extent is 50, the text will be 27.8% of the 
drawing area height.

Text Example

This figure demonstrates how the current zoom factor (size of the drawing area) affects the size 
of the text.    The size of the text is not changing (it remains 13.9) but the size relative to the size 
of the current drawing area is changing.    It is important to remember the view commands do not
change the drawing elements in any way, they simply change the view of the drawing elements.   
It is similar to the zoom on a camera.    If you zoom in on an object with your camera it appears 
to be larger, but of course, the actual size of the object remains the same.

When you print/plot the text, it will always be plotted with a height of 13.9 drawing units no 
matter what the current drawing extents.    The actual height of the text in plot units 
(inches/centimeters) on the page is determined by the print/plot scale.

To sum up, there are two factors which affect the size of the text on the display when you select a
point size in the font dialog above.    First, it is scaled by the current print/plot scale.    That value 
is stored as the text height for the text element in the drawing.    The second factor is the current 
zoom factor of the drawing area (drawing area size).    The text is drawn at the stored height 
relative to the size of the current drawing area.    There is only one factor affecting the size of the 
text when it is printed/plotted and that is the plot scale.

If you have trouble setting the text size using the text font dialog then you may want to use the 
Options/Text properties/Text height command.    With this command you can specify the text 
height directly in drawing units and not have to take the current plot scale into account.

See also:
Text Properties



Line Properties
The Options/Line properties commands allow you to specify how lines, arcs, circles and 
polylines are drawn.    All lines have the following three properties:

Line Color
Line Type
Line Width

These properties can be specified before or during the input of a drawing element.    Each layer in
the drawing has its own set of line properties.    When you choose one of these options, you are 
changing the property for the current layer only.    The selected properties remain in effect for the 
layer until another selection is made.    Whenever a line, arc or circle is created, it is displayed 
using the current line color, type and width set for the current layer.    They will always be 
displayed this way unless the properties are changed.    See the section Changing Drawing 
Element Properties for more information.



Line Color
Lines can only be displayed in solid colors.    In other words, they cannot use dithered colors 
which use a pattern of different solid colors to produce the look of another color.    The number of
solid colors available is dependent on the display device.

Line Color Dialog

To specify a line color, choose Options/Line properties/Line color from the menu.    You can also 
select a line color using the color button on the tool bar .    It is active only after you have 
chosen the line drawing command.    To make a selection from the color input dialog, simply 
click on the desired color (or highlight it using the arrow keys and press the spacebar).    Then 
press the OK button.    If a nonsolid color is chosen, the closest solid color is used instead.    You 
must also be careful not to select colors which map to the same color as the background since 
they will not be visible on the background.

See also:
Line Properties



Leader
To create a leader, you must select the position the leader will point to, then the end of the leader 
line, and finally enter the leader text.    The end of the leader arrow will fall exactly on the first 
point you select.    The second point marks the end of the leader line.    An extension line will be 
drawn from that point with a length equal to the amount specified by the Dimension offset 
command.    The leader text is placed at the end of this line.    It is always drawn horizontally.

Leader

After choosing the leader option from the dimension menu, the program prompts you for the first
end point.    Next, the program prompts for the second end point.    See the section on specifying 
positions for more information on ways of entering these two points.    The last input required to 
create a leader is the leader text.    Enter the text you wish to place at the end of the leader line 
and click on the OK button or press Enter.

See also:
Dimensioning



Text Height
To specify the height of text, choose Options/Text properties/Text height from the menu.    You 
can also set the text height using the size button on the tool bar .    It is active only after you 
have selected the text drawing command.    Enter the desired text height in the dialog box which 
appears.    This value is specified in drawing units and the displayed height of the text will vary 
depending on the current drawing area extents.

Text Height Dialog

See also:
Text Properties



Linear Dimension
To create horizontal, vertical, or parallel dimensions, you must select the two extension line 
positions and the dimension line position.    Optionally, you can change the dimension text.    The 
extension lines will be offset from the points you pick by the extension line offset specified by 
the Dimension Offset command.    The dimension line will pass through the position you specify 
for the dimension line.

Vertical Dimension

After choosing the vertical, horizontal or parallel option from the dimension menu, the program 
prompts you for the first extension line point.    Next, the program prompts for the second 
extension line point.    Lastly, you are prompted for the dimension line position.    See the section 
on specifying positions for more information on ways of entering these three points.    The last 
input required to create these dimensions is to input the dimension text.    The string defaults to 
the distance between the two extension lines in drawing units.    It is formatted according to the 
number format set by the Options/Number format command.    You can change the text any way 
you want.    For example, you may want to add the proper units to the end of the string (e.g. feet 
or meters).    You may want to change the text entirely.    Once you have entered the desired text, 
click on the OK button or press Enter.

The program will prompt you for the first extension line point again.    You can create another 
dimension of the same type or end the command.

To line up consecutive dimensions, use the Nearest element snap when selecting the dimension 
line point and snap to the previous dimension line.

See also:
Dimensioning



Radial Dimension
To create a radial dimension, you must select an arc or circle and then the dimension position and
optionally change the dimension text.    An extension line is drawn horizontally from the 
dimension point with a length equal to the amount specified by the Dimension offset command.

Radial Dimension Example 1

After choosing the radial option from the dimension menu, the program prompts you to select an 
arc or circle.    Place the box cursor so the arc or circle you want to dimension passes through it.   
Next, the program prompts for the dimension line point.    See the section on specifying positions
for more information on ways of entering these two points.    The last input required to create 
these dimensions is to input the dimension text.    The string defaults to the radius of the arc or 
circle in drawing units.    You can change the text any way you want.    For example, you may 
want to add the proper units to the end of the string (e.g. feet or meters).    You may want to 
change the text entirely.    Once you have entered the desired text, click on the OK button or press
Enter.

The program will prompt you to select a circle or arc again.    You can create another radial 
dimension or end the command.

You can create different kinds of radial dimensions depending on how you select the points for 
the dimension.    In the example below, the dimension point was selected by using the Center 
element snap.    The position of the dimension arrow is determined by the point you pick when 
selecting the arc or circle.

Radial Dimension Example 2

Arcs or circles which are part of an inserted figure cannot be dimensioned.    If you try to select 
an arc or circle which is part of an inserted figure, the program will display the message: Element
is not an arc or circle.    You will also get this message if the first drawing element the program 
finds within the selection box is not an arc or circle.    When selecting an arc or circle for radial 
dimensioning, make sure it is the only one in the selection box.



See also:
Dimensioning



Text Angle
To specify the angle of text, choose Options/Text properties/Text angle from the menu.    Enter 
the desired text angle in the dialog box which appears.    The text angle specifies the rotation of 
the baseline of the text string in degrees counter-clockwise from the x axis.

Text Angle

Windows raster fonts (e.g. Courier, Fixedsys, MS Sans Serif, MS Serif, Small Fonts, System and 
Terminal) will not rotate.

See also:
Text Properties



Text Orientation
To specify the orientation of text, choose Options/Text properties/Text orientation from the menu.
Enter the desired text orientation in the dialog box which appears.    The text orientation specifies
the rotation of the individual characters in a text string in degrees counter-clockwise.    Support 
for text orientation differs from font to font and from device driver to device driver.    The ones 
which do support text orientation may only support certain angles (e.g. 90, 180, 270).

See also:
Text Properties



Text Justification
To specify the alignment of text, choose Options/Text properties/Text justification from the menu.
When you create a text element you are asked to input the alignment point.    This point can 
represent different positions within the string depending on the current text justification setting.    
The text justification is initially set to Top and Left when the program is first loaded.    The text 
justification dialog allows you to specify one of three horizontal justification points (Left, Center
and Right) and one of three vertical justification points (Top, Baseline and Bottom).    To select 
one, click on its radio button.    When you have specified the horizontal and vertical justification, 
click on OK.

Text Justification Dialog

The figure below shows all of the possible text justification points.

Text Justification

See also:
Text Properties



Point Color
Points can only be displayed in solid colors.    In other words, they cannot use dithered colors 
which use a pattern of different solid colors to produce the look of another color.    The number of
solid colors available is dependent on the display device.

Point Color Dialog

To specify a point color, choose Options/Point properties/Point color from the menu.    You can 
also select a point color using the color button on the tool bar .    It is active only after you 
have chosen the point drawing command.    To make a selection from the color input dialog, 
simply click on the desired color (or highlight it using the arrow keys and press the spacebar).    
Then press the OK button.    If a nonsolid color is selected, the closest solid color is used instead. 
You must also be careful not to select colors which map to the same color as the background 
since they will not be visible on the background.

See also:
Point Properties



Point Type
To specify a point type, choose the Options/Point properties/Point type command from the 
menu.    You can also select a point type using the type button on the tool bar .    It is active 
only after you have chosen the point drawing command.    To select a point type, click on the 
desired type (or use the arrow keys).    Click on the OK button (or press Enter) to use the selected
point type.

Point Type Dialog

See also:
Point Properties



Point Size
To specify a point size, choose Options/Point Properties/Point size from the menu.    You can 
also select a point size using the size button on the tool bar .    It is active only after you have 
chosen the point drawing command.    Enter the desired point size.    This value is specified in 
drawing units and its displayed size will vary depending on the current drawing area extents.

Point Size Dialog

See also:
Point Properties



Fill / Hatch Color
Hatched areas can only be displayed in solid colors.    In other words, they cannot use dithered 
colors which use a pattern of different solid colors to produce the look of another color.    The 
number of solid colors available is dependent on the display device.    Filled areas can use 
dithered colors.

Fill / Hatch Color Dialog

To specify a fill / hatch color, choose Options/Fill / Hatch properties/Fill / Hatch color from the 
menu.    You can also select a fill / hatch color using the color button on the tool bar .    It is 
active only after you have chosen the fill / hatch drawing command.    To make a selection from 
the color input dialog, simply click on the desired color (or highlight it using the arrow keys and 
press the spacebar).    Then press the OK button.    If a nonsolid color is chosen for a hatched area,
the closest solid color is used instead.    In this case, you must be careful not to select colors 
which map to the same color as the background since they will not be visible on the background. 
You may use any color for filled areas.

See also:
Fill / Hatch Properties



Fill / Hatch Type
To specify a fill / hatch type, choose the Options/Fill / Hatch properties/Fill / Hatch type 
command from the menu.    You can also select a fill / hatch type using the type button on the tool
bar .    It is active only after you have chosen the fill / hatch drawing command.    To select a 
fill / hatch type, click on the desired type (or use the arrow keys).    Click on the OK button (or 
press Enter) to use the selected fill / hatch type.

Fill / Hatch Type Dialog

See also:
Fill / Hatch Properties



Dimension Arrow Scale
To specify the dimension arrow size, select Options/Dimension Properties/Dimension arrow 
scale from the menu.    Enter the desired dimension arrow scale in the dialog which appears.    
This value is the scale factor used for the arrow head symbol when it is inserted.    If the arrow 
head symbol is drawn with a length of one (as the default one is), the value you enter in this 
dialog also represents the length of the arrow head in drawing units.    You must enter this value 
in decimal, even if you have architectural number format specified for the drawing.    Click on 
the OK button when you have entered the desired scale.

Dimension Arrow Scale Dialog

See also:
Dimension Properties



Dimension Offset
To specify the dimension offset, select Options/Dimension Properties/Dimension offset from the 
menu.    Enter the desired offset in the dialog which appears.    This value is in drawing units.    
Click on the OK button when you have entered the desired scale.

Dimension Offset Dialog

The dimension offset specifies different things for the different kinds of dimensions.    For 
leaders and radial dimensions, it specifies the length of the line which extends horizontally from 
the second end point you select for the leader (see Leader).    For linear dimensions (horizontal, 
vertical and parallel), it specifies the offset of the extension lines from the first two dimension 
points you select and the distance the extension lines extend beyond the dimension line (see 
Linear Dimension).

See also:
Dimension Properties



This button locks the selected layer(s) in the layer list above this button.    When a layer is 
locked, the elements on the layer cannot be selected or edited.



Layers
The Options/Layer command allows you to create layers, rename layers, set the current layer and
set layer properties.    Every element in the drawing is on a particular layer.    When you enter a 
new drawing, the layer MAIN is automatically created and set as the current layer.    Any drawing
elements you create are placed on this layer until you specify a different layer.    Layers provide a
means of grouping drawing elements together.    For example, if you were drawing a floor plan 
you may want to place different floors on different layers (e.g. "BASEMENT" and "FLOOR1") 
and thus have one drawing with the entire floor plan instead of placing the floors in separate 
drawings.    Or you might create separate layers for the electrical wiring, plumbing and so on.

Layers can be turned on and off.    When they are off, the elements on the layer are not drawn and
cannot be edited.    Layers can be locked, which means the elements on the layer are displayed 
but they cannot be edited.    The layers can be marked as not printable, which means they are not 
printed or plotted.    This can be used to create templates and construction lines which help guide 
your drawing but should not be plotted.    These properties can be set independently for each 
layer.    One layer is always set as the current layer and any drawing elements created are placed 
on the current layer.    All of these properties can be set in the layer dialog.    This dialog is also 
used to create new layers and rename existing layers.

Each layer also has the following set of properties associated with it.
Line Type
Line Color
Line Width
Text Font
Text Height
Text Angle
Text Orientation
Text Justification
Point Color
Point Type
Point Size
Fill / Hatch Color
Fill / Hatch Type
Dimension Arrow Size
Dimension Offset

Whenever a new drawing element is created which contains one of these properties, the setting 
for the property on the current layer is used.    For example, when you create a new line, the color
is determined by the line color set on the current layer.    Once set, however, the color of the line 
remains the same even if you change the line color setting for the current layer.    The layer 
properties only affect new elements.    You must use the Edit/Change command to change the 
color of the line.    This is because the line color for the element is stored in the line element 
itself.    Its initial value is set using the settings for the current layer but after this the color is not 
tied to the layer settings.

You may create as many layers as you like.    There is no limit to the number of layers a drawing 
may contain.    The layers and their properties are stored with the drawing so each layer makes 



your drawing file larger and also increases the amount of memory needed to edit the drawing.    
There is no limit to the number of drawing elements on each layer except the amount of available
memory.



Grid Snap Parameters
To set the grid snap parameters choose the Options/Grid snap parameters command from the 
menu.    The following dialog will be displayed.

Grid Snap Dialog

This dialog allows you to specify the grid which is used when the element snap mode is set to 
Grid.    For a description of the different parts in the above dialog, click on the part.    For 
example, for a description of the X grid interval click on its edit box.

See also:
Grid Dot Size
Grid Density



Changing Drawing Element Properties
To change the properties of drawing elements, select the elements to change (see the section on 
Selecting Drawing Elements).    Then, choose Change from the Edit menu or press Ctrl+H.    This
will bring up a dialog which allows you to select what property to change.    You can only change
one property at a time.    To choose a property, click on its radio button and click on the OK 
button.

Change Dialog

The program will bring up a dialog which allows you to specify the new property.    These 
dialogs are the same ones used for the corresponding commands on the Options menu.    See the 
appropriate section under Setting Drawing Properties in this document for more information on 
using these dialogs.    The only exception to this is the Layer option.    See the section Changing 
the Layer of a Drawing Element for more information.

When the new property is specified, the selected elements are changed.    You will have to clear 
the selection set (see Clear Selection) in order to see color changes since the current selection set 
is always drawn in the selection set color.



Text Properties
The Options/Text properties commands allow you to specify how text is drawn.    Text strings 
have the following properties:

Text Font
Text Height
Text Angle
Text Orientation
Text Justification

These properties can be specified before or during the input of a text element.    Each layer in the 
drawing has its own set of text properties.    When you choose one of these options, you are 
changing the property for the current layer only.    The selected properties remain in effect for the 
layer until another selection is made.    Whenever a text element is created, it is displayed using 
the current text properties set for the current layer.    It will always be displayed this way unless 
the properties are changed.    See the section Changing Drawing Element Properties for more 
information.



Point Properties
The Options/Point properties commands allow you to specify how points are drawn.    Points 
have the following three properties:

Point Color
Point Type
Point Size

These properties can be specified before or during the input of a point element.    Each layer in 
the drawing has its own set of point properties.    When you choose one of these options, you are 
changing the property for the current layer only.    The selected properties remain in effect for the 
layer until another selection is made.    Whenever a point is created, it is displayed using the 
current point color, type and size set for the current layer.    They will always be displayed this 
way unless the properties are changed.    See the section Changing Drawing Element Properties 
for more information.



Fill / Hatch Properties
The Options/Fill/Hatch properties commands allow you to specify how filled areas are drawn.    
The following two properties can be specified for filled / hatched areas.

Fill / Hatch Color
Fill / Hatch Type

These properties can be specified before or during the input of a fill / hatch area.    Each layer in 
the drawing has its own set of fill / hatch properties.    When you choose one of these options, 
you are changing the property for the current layer only.    The selected properties remain in 
effect for the layer until another selection is made.    Whenever a filled or hatched area is created, 
it is displayed using the current type and color set for the current layer.    It will always be 
displayed this way unless the properties are changed.    See the section Changing Drawing 
Element Properties for more information.



Dimension Properties
The Options/Dimension properties commands allow you to specify how dimensions are drawn.    
The following two properties affect how dimensions are created.

Dimension Arrow Scale
Dimension Offset

These properties can be specified before or during the input of a dimension.    Each layer in the 
drawing has its own set of dimension properties.    When you choose one of these options, you 
are changing the property for the current layer only.    The selected properties remain in effect for 
the layer until another selection is made.    Whenever a dimension is created, it is displayed using 
the current arrow size and offset set for the current layer.    The dimension commands create line, 
text and insert (the arrow head) drawing elements.    Once created, they can be edited like any 
line, text or insert element.

The current line properties affect how the lines are drawn and the current text properties affect 
how the text is drawn.    The arrow head is an insertion of the symbol stored in the file 
D_ARROW.SYM.    You can modify this symbol like any other if you desire a different arrow 
head (see Modifying Symbols).



Layer Dialog
When you choose the Options/Layers command from the menu, the following dialog is 
displayed.

Layer Dialog

For a description of the different parts in the above dialog, click on the part.    For example, for a 
description of the Lock button click on the Lock button.

The layer dialog is used to set certain properties for each layer, create new layers, set the current 
layer and rename layers.    To set the lock/unlock, print/no print and on/off status of a layer or 
group of layers, you must first select the layers you wish to change.    To select a layer with the 
mouse, simply click on the desired layer.    To select a layer using the keyboard, press Tab to 
move to the box containing the list of layers.    Use the up and down arrow keys to move through 
the list and the space bar to select a layer.    Selecting a layer again unselects it (i.e. selecting a 
selected layer unselects it).    When you have the desired layer(s) selected, click on the desired 
button to change its state or use the Tab key to highlight the desired button and press Enter.    For 
example, clicking on the Off button will turn the selected layer(s) off.

To rename a layer or layers, select the layers you want to rename and click on the Rename 
button.    For each layer you selected, the program will display a dialog with the current name in 
it.    Type in the new name and click on OK.    If you do not wish to change the name of the layer, 
simply click on OK without changing the name.    Clicking on Cancel will end the command 
without changing the name of the layer currently listed and return you to the layer dialog.    Any 
layers you renamed previously will still be changed.



To set the current layer, select one layer and click on the Current button.    If more than one layer 
is selected, the program will display a warning message and the current layer will not be 
changed.    Before clicking on the Current button make sure only one layer is selected.

To add a new layer, click on the New Layer edit box (or press Tab until a cursor appears in the 
box) and type in the name of the layer you wish to create.    Press Enter or click on OK.    The 
new layer is added to the layer list.    The layer dialog remains active so you can type in more 
new layers if you desire.    Press OK again to exit the dialog.

The changes you make in this dialog do not take affect until you press the OK button and exit the
layer dialog.    Pressing Cancel exits the dialog without making the changes.

See also:
Layers



This button unlocks the selected layer(s) in the layer list above this button.    When a layer is 
unlocked, the elements on the layer can be selected and edited.



This button sets the selected layer(s) in the layer list above this button to printable.    When a 
layer is printable, the elements on the layer are drawn on the output device when the drawing is 
printed / plotted.



This button sets the selected layer(s) in the layer list above this button to not printable.    When a 
layer is not printable, the elements on the layer are not drawn on the output device when the 
drawing is printed / plotted.



This button turns on the selected layer(s) in the layer list above this button.    When a layer is on, 
the elements on the layer are drawn on the display and printer / plotter.



This button turns off the selected layer(s) in the layer list above this button.    When a layer is off,
the elements on the layer are not drawn on the display or printer / plotter.



To use this button, select one and only one layer in the layer list and then click on this button.    
The selected layer will be set as the current layer.    When a new drawing element is created, it is 
placed on the current layer.



This button allows you to rename the selected layer(s) in the layer list above this button.    After 
pressing this button, the program will display a dialog with the current name for each layer you 
selected in the layer list.    After typing in the name you desire, press the OK button.    After all 
the layers you selected have been renamed, you are returned to the layer dialog.    Pressing 
Cancel ends the command without renaming the currently displayed layer but any layers 
previously renamed remain renamed.

You cannot change the name of a layer to the same name as an existing layer.    The layer name 
cannot contain any blanks.    Any blanks you enter are stripped out of the name.    The name is 
also converted to all uppercase.



This edit box is used to create a new layer.    Type in the name of the layer you wish to create and
press Enter or click on the OK button.    If the layer does not already exist then it will be created.  
The layer name cannot contain any blanks.    Any blanks you enter are stripped out of the name.   
The name is also converted to all uppercase.



This area lists the layers in the drawing and their current settings.    The layer name is displayed 
on the right and the settings for the layer are displayed to the left in the same row.    An x in the 
Lock column indicates the layer is locked, no x indicates the layer is unlocked.    An x in the Print
column means the layer is printable, no x means it is not.    An x in the On column indicates the 
layer is on, no x indicates it is off.    The layer with an x in the Current column is the current 
layer.

This is also the area where you select which layer(s) you want to operate on.    Click on the row 
containing the layer to select it (or use the up and down arrow keys to highlight the desired layer 
and press the space bar to select it).    You may select any number of layers.    To unselect a layer 
simply select it again.    If the list is too long to display, a scroll bar will be displayed on the right.
The buttons below the layer list operate on the selected layers only.



Selection Set Color
The program displays selected elements in a certain color.    The Options/Program 
configuration/Selection set color command allows you to set the color in which selected 
elements are drawn.    This command will bring up the color selection dialog.    Choose the new 
color from this dialog and click on the OK button.    The selection set will now be displayed in 
the chosen color.

See also:
Program Configuration
Selecting Drawing Elements



Cursor Increment
The cursor moves a certain number of pixels on the display when an arrow key is pressed.    The 
cursor increment, or step size, specifies how many pixels it moves.    This value is initially set to 
1.    Larger values cause the cursor to move more quickly across the display but make it more 
difficult to position the cursor at desired coordinates.    Smaller values have the opposite effect.

To change this value, choose Cursor Increment off of the Options/Program configuration menu.  
Enter the desired cursor increment (greater than 0) and click on the OK button.    The cursor will 
move by the input number of pixels when an arrow key is pressed and the cursor is in the 
drawing area.

See also:
Program Configuration



Arc/Circle Step Factor
At certain times it becomes necessary to draw arcs and circles as a series of line segments instead
of using the standard arc and circle Windows API functions.    This occurs when it is impossible 
to specify the position of the arc or circle within the integer coordinate space used by the 
Windows GDI functions.    This can happen if you zoom in very close on a portion of an arc or 
circle, or if you specify an arc or circle with a large radius relative to your current drawing area 
extents.    In these situations, GammaCAD displays the arc or circle as a series of line segments.

The Options/Program configuration/Arc/circle step factor command allows you to adjust the 
length of the line segments used to display the arc/circle.    The program calculates a segment size
which is approximately equal to the resolution of the device.    It then multiplies that value by the
specified step factor.    The default step factor is one.    The step factor must be greater than zero.   
The smaller the value the smoother the arc/circle will appear but it will take longer to display.    
Again, this value is used only if the arc/circle cannot be displayed using the standard Windows 
API arc and circle functions.

See also:
Program Configuration



Creating a New Drawing
If you are currently editing a drawing and would like to start a new drawing, choose New from 
the File menu.    The contents of the drawing area are cleared and you are placed in a blank 
drawing.

If you select the New item from the File menu and the drawing you are currently working on has 
not been saved, a message box will appear and ask if you want to save the current drawing. If No
is chosen, any changes made to the current drawing will be lost.    Choosing Cancel, ends the 
New command and returns you to the current drawing.    If you select Yes, the drawing will be 
saved to the file name you specified previously.    If no previous name was specified, you will be 
prompted for a name.    After saving the file, you are placed in a new drawing.

The default drawing properties (e.g. line type, line color, text font, etc.) for the new drawing are 
read from the prototype drawing, if any.

When you first run the GammaCAD program, you are placed in a new drawing.



Exporting DXF Files
To create a DXF file choose the File/Dxf export command.    After selecting this command, the 
file Save As dialog is displayed.    Enter the name of the file you want the drawing written to in 
DXF format.    A DXF extension will be added if you do not specify one.    To bring the drawing 
into another program, use the DXF import command in that program    For example, in AutoCAD
you use the dxfin command.    See the documentation for that program for more information on 
importing a DXF file.

If the drawing you are exporting was originally imported from a DXF file, then any DXF 
properties contained in the drawing are also written to the DXF file.    See the section on 
importing DXF files for more information.

Certain element properties in a GammaCAD drawing need to be converted before being written 
to the DXF file.    For example, DXF files do not use the same method of specifying colors as 
used in Windows.    Colors in the GammaCAD drawing are converted to a DXF color on DXF 
export and may not appear the same as in the original drawing.    The following properties are 
handled in this manner: color, line type, point type, text style and text justification.    If a DXF 
property is present for the element, it is used and no conversion is done.

A text style is created in the DXF file for each font you have defined (and used) in the 
GammaCAD drawing.    The name of the style in the DXF file is the same as the name of the font
in GammaCAD.    If the file was originally input from a DXF file and a style with the font name 
exists then those parameters are output.    Text elements using the default System font in 
GammaCAD are output in the DXF file with no text style name which means they use the 
Standard style.    When a text element is output to the DXF file, if it contains a DXF style (as 
input from a DXF file) then it is given that style name.    If it has no DXF style name then the 
font name is used as the style name.

The line types used by GammaCAD are defined in the TABLES section of the DXF file.    These 
line types are used when a line, arc or circle is output unless a    DXF line type (as input from a 
DXF file) is present.

Filled and hatched areas created in GammaCAD are not output to the DXF file since there is no 
equivalent DXF entity.

Hints on Bringing DXF Files into AutoCAD
In AutoCAD use the style command to change the parameters associated with a text style.    Text 
orientation angles in GammaCAD are ignored when creating a DXF file.

Use the ltscale command to adjust the dash and dot spacing of lines, arcs and circles.

AutoCAD only allows one point type and one point size.    In other words, you cannot have 
points represented by a plus (+) and points represented by an x (X).    To set the point type and 
size, use the setvar command to set the variables PDMODE and PDSIZE, respectively.

GammaCAD symbols are defined as blocks in the DXF file.



The AutoCAD dxfin command functions differently depending on whether you are using it in a 
new or existing drawing.    In an existing drawing, AutoCAD will ignore everything but the 
ENTITIES section of the DXF file.    This means the text styles, line types and blocks defined in 
the DXF file are ignored by AutoCAD.    You must make sure these are defined prior to executing
the dxfin command in this case.    Use the style, linetype and block commands in AutoCAD.    
When you use dxfin to bring in a DXF file created by GammaCAD in a new drawing, everything
will be defined for you.

See also:
Using DXF Files



Opening an Existing Drawing
If you want to edit a drawing created previously, choose the Open command from the File menu 
or press the open button  on the command tool bar.    This brings up the file selection dialog.    
Select the proper drive and directory from the drive and directory lists.    Then choose one of the 
files from the file name list and click on the OK button.    The drawing in the given file will be 
displayed in the drawing area.    You must select an existing file with this option.    You can now 
edit the elements in the displayed drawing or add more elements if desired.

Open Dialog

If you choose a file from this dialog and the drawing you are currently working on has not been 
saved, a message box will appear and ask if you want to save the current drawing. If No is 
selected, any changes made to the current drawing will be lost.    Selecting Cancel, ends the Open
command and returns you to the current drawing.    If you choose Yes, the drawing will be saved 
to the file name you specified previously.    If no previous name was specified, you will be 
prompted for a name.    After saving the file, the file open dialog will be displayed.



Print/Plot Setup
The File/Print/plot setup command brings up the print setup dialog.    When you press the Setup 
button on the print dialog, which is displayed during the File/Print/plot command, the print setup
dialog is also displayed.    The print setup dialog allows you to select a printer from the printers 
you have installed in Windows.    To install a printer in Windows, use the Control Panel (see your
Windows manual).    The print setup dialog also lets you set certain parameters for the selected 
printer.    The Options button brings up another dialog which lets you set parameters specific to 
the selected printer.    When you press OK or Cancel in that dialog you are returned to the print 
setup dialog.

Print Setup Dialog

Press OK to save the changes you have made to the printer setup or press Cancel to exit the 
dialog without saving them.

See also:
Page Setup



Importing DXF Files
To bring a drawing you created in another program into GammaCAD, you must first use the 
other program to create a DXF file.    For example, in AutoCAD you use the dxfout command.    
See the documentation for that program for more information on creating a DXF file.    Once the 
DXF file is created, you can bring it into GammaCAD using the File/Dxf import command.    
After selecting this command, the file open dialog is displayed and all of the files with a DXF 
extension in the current directory are listed.    Select the file you wish to import.    The program 
reads the file and displays it.    You may need to use the View  /  Zoom extents   command to see the 
drawing if it does not fall within the current window.

GammaCAD does not support every possible drawing entity which can be present in a DXF file. 
It does preserve all the information present in the DXF file, however.    When GammaCAD 
encounters an entity in the DXF file which it does not support, the parameters which describe the
entity are stored and the entity is drawn with the following symbol .    If the drawing is later 
exported to a DXF file, the entity is written to the DXF file with the same parameters it had when
imported.    This allows you to edit drawings in GammaCAD created by another program without
losing information in the DXF import / export process.    The HEADER and TABLES section of 
the DXF file are also preserved.

The following DXF entities are supported by GammaCAD: line, arc, circle, point, text, insert, 
block, endblk, polyline, vertex and seqend.    Trace and solid entities are converted to a fill 
element on DXF import and converted back on export.    Attdef entities are displayed as text 
elements.    Attrib entities are not displayed but are preserved within the insert element.    3Dface 
entities are displayed as 2d polylines.    Shapes and associative dimensions are not supported at 
all and are drawn with the following symbol .    If you want associative dimensions to be 
displayed in GammaCAD, you must use the explode command in AutoCAD to explode them.    
Of course, they will no longer be associative dimensions.    If you use the AutoCAD setvar 
command and set the DIMASO variable to 0, then non-associative dimensions are created by 
default.

Certain entity properties in a DXF file are either not supported by GammaCAD or need to be 
converted before they can be used.    In either case, the original value of the property is preserved
in the drawing and used when the drawing is exported to a DXF file.    If the property is edited, 
the value from the DXF file is removed.    The following properties are handled in this manner: 
color, line type, point type, text style and text justification.

For example, DXF files do not use the same method of specifying colors as used in Windows.    
Colors in the DXF file are converted to a Windows color on DXF input and may not appear the 
same as in the original drawing.    The original value is stored, however, and if the drawing is 
exported to a DXF file then the original color is used.    If the color of the drawing element is 
edited in GammaCAD, the DXF color is removed.    In this case, the Windows color will be 
converted to a DXF color value when the element is output to a DXF file.

In general, if the property is something you can not do in GammaCAD then it is not supported.    
For example, you can not scale an inserted figure independently in the x and y directions in 
GammaCAD and GammaCAD ignores the y scale factor for an insert entity in a DXF file.    The 



DXF properties which are not supported by GammaCAD include: elevation, thickness, extrusion 
direction, point angle, text x-scale factor, text obliquing angle, text generation flags, some text 
justifications, block type flags, xrefs, insert attributes, insert y/z scale, insert row/column 
counts/spacing, all polyline flags except closed, polylines with different start/end widths, curved 
polyline segments and invisible edges in a 3d face.

If you import more than one DXF file into a drawing, the header section of the second DXF file 
is ignored.    Any tables or block definitions which were defined in the first DXF file are skipped 
in the second.    This can result in missing table entries if you perform a DXF export on the 
drawing.    For example, suppose you import a DXF file which contains a line type table.    Then 
you import a second DXF file into the same drawing.    The second drawing also contains a line 
type table but it is ignored because the drawing already contains a line type table from the first 
DXF file.    If the second DXF line type table contains line type definitions which were not in the 
first, they will be missing when you later export the drawing to a DXF file.    It is up to you to 
avoid this situation by making sure the first DXF file you import contains all the necessary table 
entries for both DXF files.    Or, define all required table entries in the other program before 
importing the DXF file exported from GammaCAD.

When you cut or copy drawing elements which contain DXF information to the Windows 
clipboard, the DXF information is transferred as well.    Information from the DXF header is 
NOT transferred.    When you paste these elements into another drawing, only those tables which
are not defined in the drawing are created.    In other words, DXF table entries for the clipboard 
elements are not merged with the DXF table entries in the drawing to which you are pasting.    
This is similar to importing more than one DXF file into the same drawing as described in the 
previous paragraph.

See also:
Exporting DXF Files
Using DXF Files
Display DXF Elements



Page Setup
The File/Page setup commands allow you to position your drawing on the printer / plotter page 
and set the size of the drawing on the page.    The page setup commands are:

Fit Drawing to Page
Print/Plot Scale
Position Drawing on Page

GammaCAD queries the current print driver to get the page size and printable area.    The 
File/Print/plot setup command is used to set the current printer and its page parameters.    If the 
print driver returns the page size, GammaCAD draws the page on the display using the current 
plot scale and page origin.    The lower left corner of the page is placed at the page origin.    The 
page origin is initially set to (0,0) in a new drawing.

Printer Page Display

The color of the page display will depend on the background color of the window.    The Control 
Panel is used to set the window background color.    The solid line represents the boundaries of 
the page.    The dashed line represents the printable area on the page.    Most printers do not allow
you to print all the way to the edge of the page.

The current plot scale determines the size of the displayed page.    The File/Page setup/Print/plot 
scale command allows you to set the plot scale.    The position of the page is determined by the 
page origin.    The File/Page setup/Position drawing on page command allows you to set the 
page origin.    Using the scale command, you can adjust the size of the page drawn in the display 
so the drawing fits within the printable area.    Then you can position the drawing on the page 
with the position command.    The File/Page setup/Fit drawing to page command calculates the 
plot scale and page origin automatically.    It is probably the easiest way to position the drawing 
on the printer page.    It makes the drawing as large as possible on the page and centers it on the 
page.

See also:
Display Page



Exit
The File/Exit command ends the program.    If you have any unsaved data the program will 
prompt you to save it before exiting.

See also:
Saving the Drawing



Fit Drawing to Page
The File/Page setup/Fit drawing to page command automatically sets the plot scale and page 
origin for the current drawing.    The plot scale determines the size of the drawing on the printer / 
plotter page.    The page origin determines the position of the drawing on the page, it is the 
position of the lower left corner of the page in the drawing.

After choosing this command, the program retrieves the current drawing extents.    If this is a 
new drawing and nothing has been drawn, the following dialog is displayed.

Drawing Extents Dialog

Enter the minimum and maximum coordinates you plan on using in your drawing.    For 
example, if you want your drawing to start at (0,0) and your drawing is 20 units wide and 15 
units high, enter (0,0) for the minimum and (20,15) for the maximum coordinates.    This dialog 
allows you to set up the page for your drawing before drawing it.    You can, of course, rerun this 
command at any time after creating all or part of your drawing to refit the drawing to the page.    
Again, the above dialog is not displayed if any drawing elements have been added to the 
drawing.    The extents are taken directly from the drawing elements in this case.

After the drawing extents have been determined, this command calculates the scale which makes
the drawing as large as possible on the page.    It then displays the scale it calculated in the plot 
scale dialog.    To use the calculated scale press the OK button.    If you would like to use an even 
number for the scale you can enter it in this dialog.    You should round up and not down.    If you 
specify a scale value less than the displayed value, the drawing will not completely fit on the 
page.    After the plot scale has been entered, this command calculates the page origin which 
centers the drawing on the page.    If you have moved or deleted drawing elements and the 
drawing has not been redrawn since these operations were performed, the calculated scale may 
not be correct.    The drawing extents are set each time the drawing is redrawn (e.g. when a view 
command is used).    If after running this command the drawing is not fit to the page, rerun this 
command again.

A dialog is then displayed which asks whether you would like to zoom to the new page.    If you 
choose Yes, the program performs a Zoom page.    If you choose No, the current view is not 
changed but the plot scale and page origin are changed.

See also:



Page Setup



Print/Plot Scale
The File/Page setup/Print/plot scale and File/Page setup/Fit drawing to page commands set the 
plot scale for the current drawing.    The plot scale determines the size of the drawing on the 
printer / plotter page.    Increasing the plot scale decreases the size of the drawing on the page.    
Decreasing the scale increases the size of the drawing on the page.    If you prefer to think in 
terms of fitting the page drawn on the display to the drawing, then increasing the plot scale 
increases the size of the page relative to the drawing.    Decreasing the scale decreases the size of 
the page.    Of course, the actual size of the page does not change, its size relative to the drawing 
is changing when you change the plot scale.

The following dialog is displayed when the File/Page setup/Print/plot scale command is chosen 
and also during the File/Page setup/Fit drawing to page command.    Enter the desired scale and 
press the OK button to set the plot scale.    Pressing the Cancel button closes the dialog without 
changing the plot scale.

Plot Scale Dialog

This dialog sets the number of drawing units which equal 1 plot unit.    The plot units are either 
inches or centimeters.    Select the English radio button to use inches and the Metric radio button 
to use centimeters.    When a new drawing is created, the plot units are set according to the 
setting of the Measurement field in the international section (intl) of the Windows WIN.INI file.   
These parameters can be configured using the International option in the Control Panel.    Once a
drawing has been created the plot unit setting is saved within the drawing.    Changes to the 
Measurement field in the Control Panel have no affect.    You must use the File/Page 
setup/Print/plot scale command to change the plot units.    The advantage to this is the drawing 
remembers the plot units you used and they are restored when you open the drawing.    Using a 
prototype drawing can override this default behavior.

Drawing units can be anything (e.g. inches, feet, miles, centimeters, meters, kilometers, etc.) the 
program does not care what they are.    The plot scale sets the relationship between the drawing 
units you use in the drawing and distances on the plotter.    This is all the program needs to know. 
The only exception to this is if you have chosen architectural numbers using the Options/Number
format command.    In this case, the program assumes the drawing is in inches.    For a further 
description of drawing coordinates see the Drawing Coordinate System section.

See also:
Page Setup



Position Drawing on Page
The File/Page setup/Position drawing on page command sets the page origin for the current 
drawing.    The page origin determines the position of the drawing on the printer / plotter page, it 
is the position of the lower left corner of the page in the drawing.    You may want to use the 
View/Zoom page and extents command to set the view before choosing this command.    After 
selecting the Position drawing on page command, you are prompted to enter the page origin in 
drawing units.    You can use the mouse or arrow keys to position the page (as drawn on the 
display) relative to the drawing.    Press the left mouse button or press Enter to select a position.    
Alternatively, press the right mouse button or the F2 key to bring up the coordinate input dialog.  
The initial values displayed in this dialog are the previous page origin coordinates.    Input the 
desired page origin and press Enter or click on OK.

To position a drawing using a printout you created earlier, measure the distance (in inches) you 
want to move the drawing right or left and up or down.    Convert the values you measured from 
plot units (inches) to drawing units.    To do this, simply multiply the values you measured by the 
current plot scale.    To determine the current plot scale, choose the File/Page setup/Print/plot 
scale command.    Use the value to the right of the equal sign in the edit box.    Press Cancel in 
the plot scale dialog.    Next, select the File/Page setup/Position drawing on page command and 
click the right mouse button or press F2.    Choose the XY Offset Input radio button in the box on 
the left in the coordinate input dialog.    If you want to move the drawing right, enter the distance 
you calculated previously in the DX field as a negative number.    To move it left, enter the 
distance in the DX field as a positive number.    To move the drawing up, enter the distance in the 
DY field as a negative number.    To move the drawing down, enter the distance as a positive 
number.    Press the OK button in the coordinate input dialog.    The page displayed in the drawing
area will be shifted and the next time you print the drawing it will be moved by the desired 
amounts.

Examples
You printed out your drawing and you want to move it right 0.1" and up 0.2" on the page.    Your 
plot scale is 1"=1 drawing unit.    This means you need to shift the current page origin left by 0.1 
and down by 0.2.    Remember, you are shifting the page relative to the drawing so the 
movements have to be opposite to the directions you want to move the drawing on the page.    
Choose the File/Page setup/Position drawing on page command and press the right mouse 
button.    Select the XY Offset Input radio button.    Enter -0.1 in the DX field and -0.2 in the DY 
field and press the OK button on the coordinate input dialog.    Replot the drawing.    The drawing
will be 0.1" further to the right and 0.2 inches higher on the page.

You printed out your drawing and you want to move it left 0.15" and down 0.02" on the page.    
Your plot scale is 1"=10 drawing units.    This means you need to shift the current page origin 
right by 1.5 (0.15x10) and up by 0.2 (0.02x10).    Enter 1.5 in the DX field and 0.2 in the DY 
field.

See also:
Page Setup



The Y grid interval specifies the distance between grid points in the y direction.    The value is in 
drawing units.



The X grid interval specifies the distance between grid points in the x direction.    The value is in 
drawing units.



The X grid origin specifies the x coordinate of the first grid point.    You can use this value to 
shift the grid right and left without changing the distance between grid points.    The value is in 
drawing units.



The Y grid origin specifies the y coordinate of the first grid point.    You can use this value to 
shift the grid up and down without changing the distance between grid points.    The value is in 
drawing units.



Click on this box to turn the display of the grid on and off.    When the box is checked, the grid is 
displayed.    The grid does not have to be displayed to use the grid snap feature.    If grid snap is 
on, the program snaps to the closest grid point regardless of whether the grid is displayed or not.



The Number Format Type field specifies whether floating point numbers are displayed in 
decimal, scientific, or architectural format.    When Architectural format is selected, the program 
assumes your drawing is in inches.



Set the Decimal Digits field to the number of decimal places you want the program to display to 
the right of the decimal point.    This causes the program to display that number of decimal places
everywhere it displays a real number.



The Decimal Separator specifies the character the program uses for the decimal point in a 
floating point number.



The Largest Denominator field sets the largest denominator to use in a fraction.    This value is 
used only if Architectural is selected as the number format type.



Saving the Drawing
There are 2 commands for saving the drawing, Save and Save As, both are on the File pull down 
menu.    The Save As command allows you to specify a file name.    Once a file name has been 
specified for a drawing, you save it to the same file by choosing Save or by pressing CTRL+S or 
by pressing the save button  on the tool bar.    There are no further prompts when using the 
Save command.    If the Save command is selected before a file name has been specified, the Save
As command is used instead of Save.

The Save As command brings up a file selection dialog box.    To specify a file name, choose a 
drive from the drive list and a directory from the directories list.    Type in the name of the file in 
the File Name box.    You do not have to specify an extension for the file name.    If you do not 
specify one, the extension GC1 will be appended to the name you enter.    It is recommended you 
use a GC1 extension on all your drawing files so they will appear in the list of file names in the 
file selection dialog.    If you enter an existing file name, the program will warn you and ask if 
you want to replace it.    Choosing Yes will completely replace the contents of the file with the 
current drawing.    The previous file will be renamed with a GCB extension.    The file name 
dialog will not allow you to enter an invalid path or file name.

Save As Dialog

When the desired drive, path and file name have been entered, press the OK button and the 
current drawing will be saved.    The previous drawing file (if any) with the input name will be 
renamed with a GCB extension as a backup.

When a drawing is saved all the undo levels are removed.    This means previous operations 
cannot be undone after a save has been performed.    This is done to free up the memory used by 
the undo feature.



Selecting Drawing Elements
The Cut, Copy, Delete, Rotate, Scale, Change and List commands require one or more drawing 
elements be selected first.    They are grayed out and unselectable if no drawing elements are 
selected.    The Edit/Select commands allow you to create a new selection of drawing elements, 
add elements to the current selection, remove elements from the current selection and clear the 
selection.    There is only one selection of drawing elements maintained by GammaCAD.    The 
elements in that selection (if any) are displayed in the selection color.    The selection color is 
initially set to light gray but it can be changed using the Options/Program 
configuration/Selection set color command.

When selecting drawing elements, you input opposite corners of a rectangular area and all 
elements which fall within this area or cross it will be selected.    You may pick any corner of the 
area first.    To choose the first corner, click the left mouse button at the desired position and hold 
the left mouse button down.    Drag the mouse cursor to the opposite corner of the desired 
selection area.    After choosing the first corner, as you move the cursor, a box is displayed with 
one corner at your first selection point and the opposite corner at your current cursor position.    
This box represents the selection area.    When the desired selection box is displayed, release the 
left mouse button.    This sets the second corner of the selection area.    Element snaps do not 
affect the points you pick during drag selection.

Selecting Elements

To select elements using the keyboard, use the arrow keys to position the cursor at the first 
corner of the selection area.    Press and hold down the Enter key.    Move the cursor to the second
corner off the selection area using the arrow keys and release the Enter key.

When the second point is chosen, the program either creates a new selection with the elements in
the selection box, adds them to the current selection, or removes them from the current selection. 
It depends on the current selection mode.

The selection mode can be set using the menu or command tool bar.    The selection mode can be 
either new, add or remove.    In new mode, when you select drawing elements, the old selection is
removed and only the newly selected elements are selected.    In add mode, the selected elements 
are added to any previous selection.    In remove mode, the selected elements are removed from 
the previous selection.    When the Add item on the Edit/Select menu has a check mark next to it, 
the program is in add mode.    When Remove is checked, the program is in remove mode.    When 
neither is checked, the program is in new mode.

The add tool bar button  corresponds to the check mark on the Edit/Select/Add menu 



command.    When the add button is pressed, the Add menu option is checked and vice versa.    
The remove tool bar button 

 corresponds to the Edit/Select/Remove menu command in the same way.    When neither tool 
bar button is pressed, the program is in new selection mode.    The plus (+) and minus (-) keys on 
the numeric keypad can also be used to set the add and remove modes, respectively.

To remove the current selection of drawing elements, use the Edit/Select/Clear command.    After
choosing this command, no drawing elements are selected.

When selecting lines, polylines, arcs and circles with a width, you must make sure the center line
of the element passes through the selection area to select it.

The following sections give a step by step description on:
Creating a New Selection
Selecting Elements One at a Time
Adding Elements to the Current Selection
Removing Elements from the Current Selection
Clearing the Current Selection



Creating a New Selection
There are two ways to create a new selection.

One
Choose the Edit/Select/New selection command.    The program displays the following prompt:

Select first corner of selection area.

Move the cursor to the desired position and click and release the left mouse button or press Enter.
The program will then display the prompt:

Select second corner of selection area.

Move the cursor to the opposite corner of the desired selection area and click and release the left 
mouse button or press Enter.    Any previous selection is removed and all of the drawing elements
within or crossing the selected area will be selected.

Two
Make sure neither the Add or Remove item is checked on the Edit/Select menu.    Click on a 
checked item to uncheck it.    Or, use the command tool bar to accomplish the same thing.    If 
either the add  or remove 

 button is pressed, click on it to unpress it.    Next, click on the first corner of the desired 
selection area and drag the cursor to the opposite corner and release the left mouse button.    Any 
previous selection is removed and all of the drawing elements within or crossing the selected 
area will be selected.

See also:
Selecting Drawing Elements



Adding Elements to the Current Selection
To add elements to the current selection, make sure the Edit/Select/Add menu item is checked.    
To check the item, choose it on the menu.    Or, to accomplish the same thing using the command 
tool bar, make sure the add button  is pressed.    Click on it with the cursor if it is not pressed.  
Next, click on the first corner of the desired selection area and drag the cursor to the opposite 
corner and release the left mouse button.    All of the drawing elements within or crossing the 
selected area will be added to the current selection.

See also:
Selecting Drawing Elements



Removing Elements from the Current Selection
To remove elements from the current selection, make sure the Edit/Select/Remove menu item is 
checked.    To check the item, select it on the menu.    Or, to accomplish the same thing using the 
command tool bar, make sure the remove button  is pressed.    Click on it with the cursor if it 
is not pressed.    Next, click on the first corner of the desired selection area and drag the cursor to 
the opposite corner and release the left mouse button.    All of the drawing elements within or 
crossing the selected area will be removed from the current selection.

See also:
Selecting Drawing Elements



Moving Drawing Elements
Elements within the drawing can be moved from one position to another by using a combination 
of the Cut and Paste commands on the Edit menu.    To move a drawing element, first select the 
element(s) you want to move.    See the section on selecting drawing elements for information on
how to do this.

After selecting the desired drawing elements, choose the Edit/Cut command from the menu or 
press the cut button on the tool bar .    The prompt area will display:

Select cut reference point

The point you pick will correspond to the alignment point you select when you perform the paste
operation.    Once the reference point has been entered, the selected elements will be erased from 
the display and deleted from the drawing.    If the selection is larger than 64k it cannot be cut to 
the clipboard.    You will get the message: Selection too large!

Next, choose Paste from the Edit menu.    The prompt line will display:

Select paste alignment point

As mentioned previously, the paste alignment point corresponds to the cut reference point.      
When an alignment point is selected, the elements cut previously are drawn at the new position 
and added to the drawing.

Moving Drawing Elements

The elements may be pasted as many times as desired at any location in the drawing area.    To 
end the paste command, choose another command from the menu or click the stop  button on 
the tool bar.

The cut operation copies the selected elements to the Windows clipboard. The paste operation 
retrieves them from the clipboard and inserts them into the drawing.    The Paste command is 
grayed out and unselectable if no data has been cut or copied to the clipboard.

This program uses a private data format when storing data in the clipboard.    This is because 
none of the currently defined clipboard formats provide enough information for drawing 
elements to be cut or copied to the clipboard and pasted back without loss of information.    This 
means drawing elements cut or copied to the clipboard cannot be pasted into other programs 
unless they specifically support the GammaCAD clipboard format.    Also, the GammaCAD 
Paste command cannot paste things from the clipboard which were cut/copied by another 



program.    See the Edit/Copy bitmap command for information on how to copy a bitmap from 
GammaCAD to another program.

See also:
Copying Drawing Elements
Moving / Copying Drawing Elements to Another Drawing



Copy Bitmap
The Copy Bitmap command on the Edit pull down menu allows you to select a rectangular area 
in the drawing area to be copied to the Windows clipboard as a bitmap.    The bitmap can be 
pasted into any program which allows you to paste a bitmap.    After choosing this command, the 
prompt area will display:

Select first corner of bitmap area

When selecting the area, you input opposite corners of a rectangular area.    You may pick any 
corner of the area first.    After choosing the first corner, the first line of the prompt area becomes:

Select second corner of bitmap area

Now you must enter the diagonally opposite corner of the bitmap area rectangle.    As you move 
the cursor, a box is displayed with one corner at your first selection point and the opposite corner
at your current cursor position.    This represents the area which would be used for the selection if
the current cursor position were used for the second point.

When the second point is chosen, the program copies the selected area to the clipboard as a 
bitmap.    To paste it into another program, change to that program and select Paste from its 
menu.    Not all programs will paste a bitmap.    See the documentation for the program you want 
to paste a drawing into for more information.

GammaCAD will not paste a bitmap from the clipboard.    The GammaCAD Paste command will
only paste drawing elements placed in the clipboard using the Copy or Cut options on the 
GammaCAD Edit menu.



Copying Drawing Elements
Elements within the drawing can be copied to another position by using a combination of the 
Copy and Paste commands on the Edit menu.    To copy a drawing element, first select the 
element(s) you want to copy.    See the section on selecting drawing elements for information on 
how to do this.

After selecting the desired drawing elements, choose the Edit/Copy command from the menu or 
press the copy button  on the tool bar.    The prompt area will display:

Select copy reference point

The point you pick will correspond to the alignment point you select when you perform the paste
operation.    Unlike the Cut command, the Copy command does not delete the selected elements.  
They remain in the drawing.    If the selection is larger than 64k it cannot be copied to the 
clipboard.    You will get the message: Selection too large!

Next, choose Paste from the Edit menu or press the paste button  on the tool bar.    The prompt
line will display:

Select paste alignment point

As mentioned previously, the paste alignment point corresponds to the copy reference point.    
When an alignment point is selected, the elements copied previously are drawn at the new 
position and added to the drawing.

Copying Drawing Elements

The elements may be pasted as many times as desired at any location in the drawing area.    To 
end the paste command, select another command from the menu or click on the stop button  
on the command tool bar.

The copy operation copies the selected elements to the Windows clipboard.    The paste operation
retrieves them from the clipboard and inserts them into the drawing.    The Paste command is 
grayed out and unselectable if no data has been cut or copied to the clipboard.

This program uses a private data format when storing data in the clipboard.    This is because 
none of the currently defined clipboard formats provide enough information for drawing 
elements to be cut or copied to the clipboard and pasted back without loss of information.    This 
means drawing elements cut or copied to the clipboard cannot be pasted into other programs 



unless they specifically support the GammaCAD clipboard format.    Also, the GammaCAD 
Paste command cannot paste things from the clipboard which were cut/copied by another 
program.    See the Edit/Copy bitmap command for information on how to copy a bitmap from 
GammaCAD to another program.

See also:
Moving Drawing Elements
Moving / Copying Drawing Elements to Another Drawing



Moving / Copying Drawing Elements to Another Drawing
Drawing elements can be moved and copied between drawings as well as within the same 
drawing.    To do this, perform the cut or copy operation just as you do for moving/copying 
elements within the same drawing.    Then run another copy of the GammaCAD program and 
open the drawing to which you wish to move/copy the elements.    Paste the elements into that 
drawing.    Alternatively, instead of loading another copy of GammaCAD, you can open the 
drawing you want to paste the elements into within the current instance of the program.    The 
first method requires more memory but is much more convenient, especially if you need to 
perform multiple copy operations.

See also:
Moving Drawing Elements
Copying Drawing Elements



Deleting Drawing Elements
To delete drawing elements, first select the elements to delete (see the section on Selecting 
Drawing Elements).    Then choose Delete from the Edit menu or press the Delete key.    The 
selected elements are deleted from the drawing and erased from the drawing area.



Rotating Drawing Elements
To rotate drawing elements, select the elements to rotate (see the section on Selecting Drawing 
Elements).    Then, choose Rotate from the Edit menu.    The prompt area will display:

Select rotation reference point

After picking a position, a dialog is displayed which allows you to enter the desired rotation 
angle.    Enter the angle in degrees counterclockwise and click on the OK button.    The selected 
elements will be rotated about the given center point by the given angle.

Rotating Drawing Elements

The program continues to prompt you for a rotation center point.    You can pick another point 
and rotate the elements again or end the command by clicking on the stop button  on the 
command tool bar.



Scaling Drawing Elements
This command is used to increase or decrease the size of drawing elements.    First, you need to 
select the elements to scale (see the section on Selecting Drawing Elements).    Then, choose 
Scale from the Edit menu.    The prompt area will display:

Select scale reference point

After picking a position, a dialog is displayed which allows you to enter the desired scale factor.  
A factor greater than one increases the size of the selected elements and a factor greater than 0 
but less than 1 reduces the size of the elements.    For example, a scale factor of 2 doubles the 
size of the elements.    A scale factor of 0.5 halves the size of the elements.    A scale factor less 
than 0 will cause the symbol to be mirrored across x and y axes centered at the reference point.    
When the desired scale factor has been input, click on the OK button.    The selected elements 
will be scaled about the given reference point by the input scale factor.

Scaling Drawing Elements

The program continues to prompt you for a scale reference point.    You can pick another point 
and scale the elements again or end the command by clicking on the stop button  on the 
command tool bar.



Clearing the Current Selection
To remove the current selection of drawing elements use the Edit/Select/Clear command.    After 
choosing this command, no drawing elements are selected.

See also:
Selecting Drawing Elements



Listing Drawing Element Properties
With the List option on the Edit pull down menu you can display the properties of the selected 
elements (see Selecting Drawing Elements).    First, select the elements to list and then pick List 
from the Edit menu.    A dialog with the properties for the first element in the selection set is 
displayed.    Press OK to display the next element's properties or Cancel to end the command.



Trimming Lines, Arcs and Circles
The Edit/Break end command allows you to remove a section from the end of a line or arc.    The 
Edit/Break middle command allows you to remove a section from the middle of a line, arc or 
circle.



Break End
The Edit/Break end command is used to remove a section from the end of a line or arc.    When 
you choose this command, the prompt area displays:

Select end of line or arc to break

The cursor is changed to the box cursor.    Move the cursor so the line or arc you want to break 
passes through the box.    The cursor should be closest to the end you want to remove.    Click the 
left mouse button or press Enter.    The prompt area displays:

Select break point

Move the cursor to the position where you want the line to end and click the left mouse button or
press Enter.

Break End Example

The program prompts you to select another line or arc to break.    You can select another or click 
on the stop button  on the command tool bar to end the command.

Using the Intersection element snap to enter the break point, you can trim a line to another line.   
Choose the Edit/Break end command and select the end of the line you want to trim.    Select the 
intersection snap mode before entering the break point and move the box cursor so it contains the
intersection of the line you are trimming and the trim line.    You can also trim a line to an arc or 
circle using this method, as well as trim an arc to a line.

Trimming One Line to Another



Break Middle
The Edit/Break middle command is used to remove a section from the middle of a line, arc or 
circle.    You can choose this command by selecting it from the menu or by pressing the break 
button  on the command tool bar.    When you choose this command, the prompt area displays:

Select a line, arc or circle to break

The cursor is changed to the box cursor.    Move the cursor so the line, arc or circle you want to 
break passes through the box.    Click the left mouse button or press Enter.    The prompt area 
displays:

Select first break point

Move the cursor to the first end of the section you want to remove from the line, arc or circle and
click the left mouse button or press Enter.    The program displays the prompt:

Select second break point

Move the cursor to the other end of the section you want to remove and click the left mouse 
button or press Enter.

Break Middle Example

The program prompts you to select another line, arc or circle to break.    You can select another or
click on the stop button  on the command tool bar to end the command.

Using the Intersection element snap to enter the break points, you can trim a line to another line.  
Choose the Edit/Break middle command and select the end of the line you want to trim.    Select 
the intersection snap mode before entering the break points and move the box cursor so it 
contains the intersection of the line you are trimming and the trim line.    You can also trim a line 
to an arc or circle using this method, as well as trim an arc to a line.

Trimming an Arc to Two Lines

When you break a circle, the order in which you choose the 2 break points determines whether 
the resulting arc has an interior angle greater than or less than 180 degrees.



Breaking Circles



Extending Lines and Arcs
The Edit/Extend command is used to extend a line or arc.    A line can be extended to another 
line, arc or circle.    An arc can be extended to a line.    You can choose this command by selecting
it from the menu or by pressing the extend button  on the command tool bar.    When you 
choose this command, the prompt area displays:

Select line, arc or circle boundary for extend

The cursor is changed to the box cursor.    Move the cursor over the line, arc or circle you want to
use as the extend boundary and click the left mouse button or press Enter.    This is the element to
which other elements will be extended.    If you selected a line for the extend boundary, the 
prompt area displays:

Select line or arc to extend to the input boundary

If you selected an arc or circle as the extend boundary, the prompt displays:

Select line to extend to the input boundary

Move the box cursor so the drawing element you want to extend passes through it.    Click the 
left mouse button or press Enter.

Extend Example

The element is then extended to the input boundary.    The program prompts you to select another
drawing element to extend.    You can select another or click on the stop button  on the 
command tool bar to end the command.

When extending a line to an arc or circle it can often be extended to two positions on the arc or 
circle.    The position closest to your selection point is used.    You cannot extend an arc to a 
circle.    If you select an invalid drawing element for the extension boundary or for an element to 
extend, the program will display a warning message.    If the drawing element which is selected 
for extension does not intersect the extension boundary, the element is not extended.



Filleting Two Lines
The Edit/Fillet command is used to fillet two lines.    Filleting adds a tangent arc of the given 
radius between the two selected lines.    The lines are trimmed to the ends of the arc.    After 
choosing this command, the following dialog is displayed

Fillet Parameters Dialog

This dialog sets the size of the fillet arc.    You may enter its radius, arc length, chord length or 
tangent length.    The Distance Type field sets what type of distance you are entering in the 
Distance field.    If you enter a value of zero for the distance, the fillet lines will be extended or 
trimmed as needed so they meet and no fillet arc is created.    Press the OK button when the 
desired parameters have been entered.

The program then displays the following prompt:

Select first line to fillet

The cursor is changed to the box cursor.    Move the cursor so the line you want to fillet passes 
through the box.    Click the left mouse button or press Enter.    The prompt area then displays:

Select second line to fillet

Select the second line in the same way as the first.

Fillet Example

The two lines are then filleted.    The program prompts you to select two more lines to fillet.    
You can perform another fillet or click on the stop button  on the command tool bar to end the
command.    If the selected lines cannot be filleted using the input arc parameters (e.g. the arc is 
too large to fit within the lines), the program will display a warning message.

The positions you use to select the 2 fillet lines determines how the lines are filleted.    They 



delineate the interior angle of the fillet.
'

Fillet Example 2



Converting Polylines to Line Segments
The break, fillet and extend commands will not work with polylines.    If you want to use one of 
these commands on two polyline segments, you can Explode the polyline.    This will convert 
each polyline segment to a line element.    The polyline element is removed from the drawing.    
The Edit/Explode command converts a polyline to line elements.    After choosing this command,
the prompt area displays:

Select a polyline to explode

The cursor is changed to the box cursor.    Move the cursor so the polyline you want to explode 
passes through the box.    Click the left mouse button or press Enter.    The program will display a
message box telling you the polyline has been converted to line elements.    If the element you 
chose is not a polyline, a warning message will be displayed.    The program continues to prompt 
you to select another polyline to explode.    You can explode another polyline or click on the stop 
button  on the command tool bar to end the command.



Undoing Changes to the Drawing
The Undo command on the Edit pull down menu can be used to undo edit operations.    If there 
are no edit operations which can be undone, the Undo command is grayed and unselectable.    
You can also choose the undo command by pressing the undo button  on the command tool 
bar.

All of the commands on the Edit menu can be undone with the exception of the Select, Copy, 
List, Redefine symbol and Copy bitmap commands.    You also cannot undo an Undo command.    
The commands on the Draw menu can also all be undone.



Modifying the Dimension Arrow Head
The dimension commands insert the symbol contained in the file D_ARROW.SYM as the arrow 
head(s) on the dimension line.    You can change the arrow head like any other symbol.    See the 
section on modifying symbols.



Zooming In on an Area of the Drawing
To view an area of the drawing in more detail, use the Zoom Window command on the View 
menu.    With this command, you input a rectangular area within the drawing area.    That area is 
enlarged to cover the entire drawing area.

Zoom Window

When you choose Zoom Window from the View menu, press Ctrl+W or press the zoom window 
button  on the command tool bar, the prompt area changes to:

Select first corner of zoom window

You may select any corner of the area you want to enlarge.    Once you have selected the first 
corner the prompt changes to:

Select second corner of zoom window

As you move the cursor, a box is drawn from the first point entered to the current cursor position.
This box represents the area which will be enlarged if the current cursor position is selected.    
When the second point is selected, the input area is enlarged as much as possible while still 
displaying the entire area selected.    If the area you input is of a different shape than the shape of 
the current drawing area, you may get some elements in the drawing area which were not in the 
area selected and the enlargement may not be as much as expected.    Keep in mind, this 
command displays the entire area selected at a minimum.    It will display more in one direction, 
if necessary, to display the entire area in the other direction.    The aspect ratio of the drawing 
elements is not changed.

Effects of Zoom Window Shape



Displaying the Entire Drawing
To display all the elements in the drawing within the drawing area, use the Zoom Extents 
command on the View menu.    This command will display all the drawing elements as large as 
possible within the drawing area.    You may need to use this command more than once to get the 
drawing zoomed as large as possible if drawing elements have been moved or deleted since the 
last time the drawing was redrawn.



Restoring a Previous View
To display the previous view, choose Zoom Previous from the View menu, press Ctrl+R, or press 
the zoom previous button  on the command tool bar.    If there is no previous view to restore, 
the Zoom Previous option is grayed and unselectable.    Up to 10 previous views are saved and 
can be restored.



Zooming In and Out
The drawing may be zoomed in (enlarged) and out (shrunk) using the Zoom Factor option on the
View menu.    When you choose this option, a dialog box appears which prompts you for a zoom 
factor.    To zoom out, specify a number greater than 0 but less than 1.    To zoom in, specify a 
number greater than 1.    For example, specifying a value of 2 causes the drawing to be displayed 
at twice its current size.    Specifying a value of 0.5 causes the drawing to be displayed at half its 
current size.

The current center point of the display area remains in the center after the zoom.

Zoom Factor (factor = 0.5)



Displaying the Page View
To change the view of your drawing to one in which the printer / plotter page fills the drawing 
area, choose Zoom page from the View menu.    See the section on page setup for a further 
description of the printer / plotter page and its size and position relative to your drawing.



Displaying the Page and Entire Drawing
To change the view of your drawing to one in which the printer / plotter page and the entire 
drawing is displayed in the drawing area, choose Zoom page and extents from the View menu.    
See the section on page setup for a further description of the printer / plotter page and its size and
position relative to your drawing.



Pan
The drawing elements may be moved right, left, up and down in the drawing area while still 
maintaining the current zoom factor by using the Pan option on the View menu.    You can choose
this option by selecting it from the menu or by pressing the pan button  on the command tool 
bar.    Choosing this option changes the prompt area to:

Select first point defining pan movement

Pick a position within the drawing area you want to move elsewhere. The first line of the prompt 
area changes to:

Select second point defining pan movement

Pick the position you would like the first point to be moved to within the drawing.    The drawing
area will be redrawn with the drawing elements shifted by the specified amount.

Pan



Redraw
During the course of drawing and editing you may get extra tic marks and such within the 
drawing area which are not actually part of the drawing.    To erase the drawing area and redraw 
only the elements actually in the drawing, choose Redraw from the View menu.



Entering Decimal Numbers
Many options in this program require you to enter coordinates or distances in drawing units.    
The format in which you enter these numbers is set by the Options/Number format command.    
When the format is set to Decimal, you must enter numbers in decimal format.    To enter a 
number in decimal format, you specify the number of whole drawing units, followed by the 
decimal character, followed by the fractional part (e.g. 1.234).    You may enter any number of 
decimal places you wish.    The program will read them all no matter what you have set the 
number of decimal places to using the Options/Number format command.    When the number is 
redisplayed, it will only contain the number of decimal places set by the Options/Number format 
command, although internally it will still contain all the decimal places.    If the number is being 
displayed in an editable field in a dialog and you press the OK button in the dialog, the value will
be changed to the displayed value.    Any extra decimal places will be lost.    If you just want to 
view the values in a dialog and not change them, you should press the Cancel button to exit the 
dialog.

For example, if you enter a plot scale of 1.234 using the File/Page setup/Print/plot scale 
command the plot scale will be set to 1.234.    If you currently have the number of decimal places
set to 2 and you choose the plot scale command again, it will display a scale of 1.23.    The 
program rounds the number to 2 decimal places in the dialog.    It is still stored as 1.234 but if 
you press the OK button in the plot scale dialog then the value is changed to 1.23.    In this case it
might be best to set the number of decimal places to 3.



Entering Scientific Numbers
Many options in this program require you to enter coordinates or distances in drawing units.    
The format in which you enter these numbers is set by the Options/Number format command.    
When the format is set to Scientific, you must enter numbers in scientific notation.    To enter a 
number in scientific format, you specify the mantissa, followed by the letter "e" and then the 
exponent which is the power of 10 by which to multiply the mantissa.    The number of decimal 
places in the mantissa is set in the Options/Number format command.    For example, "1.23e2" 
represents 1.23x10x10 or 123.    The value 1.23 is the mantissa in this example and it is 
multiplied by 10 to the second power.    The coordinates are limited to the range -1e100 to 1e100. 
Coordinates within the range -1e-100 to 1e-100 cannot be entered.

Examples:
1.23e2 123.
1.23e-2 0.0123
-1.23e2" -123.



Entering Architectural Numbers
Many options in this program require you to enter coordinates or distances in drawing units.    
The format in which you enter these numbers is set by the Options/Number format command.    
When the format is set to Architectural, you must enter numbers in architectural format.    The 
program assumes your drawing is in inches when you select this mode.    To enter a number in 
architectural format, you specify the number of feet (if any), followed by an apostrophe (').    
Then you enter the number of whole inches (if any) followed by a space.    Next enter the 
fractional number of inches.    Separate the numerator and denominator by a forward slash (/).    
Do not use any spaces in the fraction.    You may include double quotes (") at the end if you 
desire, but they are not required.

There must be a space between the whole number of inches and the fractional number of inches.  
For example, 2 and 3/4 inches must have a space between the 2 and the 3 (e.g. 2 3/4).    There can
be no spaces in the fraction (i.e. no spaces in 3/4).    There must be an apostrophe following the 
number of feet. (e.g. 5').

Examples:
1/4" 1/4 inch
1/4 1/4 inch
2" 2 inches
2 2 inches
2 1/4" 2 and 1/4 inches
2 1/4 2 and 1/4 inches
1' 1 foot
1'1" 1 foot and 1 inch
1'1 1 foot and 1 inch
1'1 1/4" 1 foot and 1 and 1/4 inches
1'1 1/4 1 foot and 1 and 1/4 inches



File Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

New
Open    
Save    
Save as
Print/plot setup
Page setup
Print/plot
Dxf import
Dxf export
Exit



Draw Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Line    
Arc    
Circle    
Point
Text    
Insert symbol
Load symbol library
Dimension
Polyline
Rectangle
Fill / Hatch
Stop    



Edit Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Undo    
Select
Cut    
Copy    
Paste    
Delete
Rotate
Scale
Change
List
Break end
Break middle    
Extend    
Fillet
Explode a polyline
Change text
Open/Close a polyline
Redefine symbol
Copy bitmap



View Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Zoom window    
Zoom extents
Zoom previous    
Zoom factor
Zoom page
Zoom page and extents
Pan    
Redraw



Options Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Line properties
Text properties
Point properties
Fill / Hatch properties
Dimension properties
Layers
Set base point
Grid snap parameters
Number format
Display page
Display DXF elements
Program configuration
Enter coordinates

Color button    
Type button    
Size button    



Help Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Contents
On current command    
Keyword search
Keyboard
Commands
Tutorials
Examples
Using help
About



Ending a Command
Many of the commands in GammaCAD repeat.    In other words, after performing the operation 
once, the program prompts you to perform the same operation again until you end the command. 
Choosing a different command from the menu (except for the Snaps, Options, and Help 
commands) ends the current command.    You can end the current command by selecting 
Draw/Stop, pressing the escape key (Esc), or clicking on the stop button  on the command 
tool bar.



Pick a Position
This is the easiest method of specifying a position in the drawing area when a command prompts
you to enter a point.    All you have to do is position the cursor at the desired point in the drawing
area using the mouse or keyboard arrow keys.    Then click the left mouse button or press Enter.    
The disadvantage to using this method is you cannot specify the exact coordinates of the point.

For example, if you wanted to pick a point at exactly (10,10), you could not do it using this 
method.    This is due to the fact the cursor moves in steps.    This method is best used when you 
do not care about the exact positions and dimensions of what you are drawing.

See also:
Specifying Positions



Coordinate Input Dialog
The coordinate input dialog allows you to specify a position in the drawing area when a 
command prompts you to enter a point.    It allows you to specify an exact position.    To use this 
method, click the right mouse button or press F2 while the cursor is in the drawing area (or 
choose Enter Coordinates from the Options pull down menu).    This will bring up a coordinate 
input dialog.    You use this dialog to enter the exact (x,y) coordinates of a drawing position.    
This method is used when you have the exact coordinates or dimensions of the object you are 
drawing.    The dialog is only displayed if the program is currently prompting you to enter a 
point.    In other words, you must first select a command.    When the program prompts you to 
enter a point, click the right mouse button to bring up the coordinate input dialog.

Coordinate Input Dialog

You may enter the xy coordinates of the point in this dialog.    You may also enter a distance and 
angle (polar coordinates) from the last point entered, or an xy offset from the last point entered.   
To choose the desired mode, click on the appropriate radio button in the left box.    The prompts 
before the two fields on the right will change depending on the mode you selected.    The next 
time this dialog is brought up it will be in the same mode.    After choosing the desired input 
mode, enter the two values on the right.    The program calculates the proper position and uses it 
as the next point for whatever you are currently drawing.    When entering the two values on the 
right, you must use the current number format as set by the Options/Number format command.    
See the Coordinate Input Examples section for examples on how to use this dialog.

See also:
Specifying Positions
Entering Decimal Numbers
Entering Scientific Numbers
Entering Architectural Numbers



Color Button
The color button  on the command tool bar allows you to set the color for the drawing 
element you are currently creating.    You must choose an option from the Draw menu before this
button becomes active.    For example, after selecting the Draw/Line command the color button is
activated.    Clicking on this button will bring up the color input dialog and allow you to specify 
the color of the line you are about to create.    With this button you can specify the color of lines, 
arcs, circles, points, text, dimension lines, polylines, rectangles and filled areas.    The element 
you are setting the color for depends on the currently active draw command.

See also:
Line Color
Text Font
Point Color
Fill / Hatch Color



Type Button
The type button  on the command tool bar allows you to set the type for the drawing element 
you are currently creating.    You must choose an option from the Draw menu before this button 
becomes active.    For example, after selecting the Draw/Line command the type button is 
activated.    Clicking on this button will bring up the line type dialog and allow you to specify the
type of the line you are about to create.    With this button you can specify the type of lines, arcs, 
circles, points, text, dimension lines, polylines, rectangles and filled areas.    The element you are 
setting the type for depends on the currently active draw command.

See also:
Line Type
Text Font
Point Type
Fill / Hatch Type



Help Contents
The Help/Contents command brings up the contents page of this help document.



Size Button
The size button  on the command tool bar allows you to set the size of the drawing element 
you are currently creating.    You must choose an option from the Draw menu before this button 
becomes active.    For example, after selecting the Draw/Line command the size button is 
activated.    Clicking on this button will bring up the line width dialog and allow you to specify 
the width of the line you are about to create.    With this button you can specify the width of lines,
size of points and text height.    The element you are setting the size for depends on the currently 
active draw command.

See also:
Line Width
Text Height
Point Size



Help on the Current Command
To get help on the current command select Help/On the current command from the menu, press 
the F1 key or click on the help button  on the command tool bar.    This option is available 
only if a command is currently active.    For example, to get help on the line command, choose 
Draw/Line from the menu and then choose Help/On the current command.    The Windows help 
facility is loaded and you are positioned at the section describing the line command.



Help Keyword Search
The Help/Keyword search command brings up the windows help search facility and lets you 
search for a topic by keyword.



Help Using Help
The Help/Help using help command brings up the help file which describes using the windows 
help facility.



Help About
The Help/About command brings up a dialog which displays the program name, version and 
copyright information.



Changing Text Strings
The Edit/Change text command allows you to modify an existing text string.    Only the text is 
changed, the font, justification, angle and orientation remain the same.    After choosing this 
command, the prompt area displays:

Select a text string to edit

The cursor is changed to the box cursor.    Move the cursor so the text string you want to edit 
passes through the box.    Click the left mouse button or press Enter.    The program will display a
dialog box containing the current text string.    Change the text to whatever you like and press the
OK button.    If the element you selected is not a text string a warning message will be displayed. 
The program continues to prompt you to select another text string to edit.    You can edit another 
text string or click on the stop button  on the command tool bar to end the command.



Open/Close a Polyline
The Edit/Open/Close a polyline command changes open polylines to closed and closed polylines 
to open.    After choosing this command, the prompt area displays:

Select a polyline to open/close

The cursor is changed to the box cursor.    Move the cursor so the polyline you want to 
open/close passes through the box.    Click the left mouse button or press Enter.    The program 
will close the polyline if it is open and open it if it is closed.    If the element you selected is not a 
polyline then a warning message will be displayed.    The program continues to prompt you to 
select another polyline to open/close.    You can open/close another polyline or click on the stop 
button  on the command tool bar to end the command.

See the Draw/Polyline section for an explanation of open and closed polylines.



Open Polyline
To Draw an open polyline, all you have to do is choose the Draw/Polyline/Open polyline 
command from the pull down menu.    The prompt area will display:

Select first end point of open polyline

After specifying the first end point, a line is drawn from that point to the current cursor position 
as you move the cursor.    This represents the first segment of the polyline which would be added 
to the drawing if the current cursor position was used for the second end point.    The prompt area
changes to:

Select next end point of polyline

When the second end point is specified, a polyline segment with the designated start and end 
points is added to the drawing.    It is displayed using the current line properties in effect.    The 
program continues to prompt you for the end point of the next segment of the polyline.    If you 
wish to add another segment which starts at the end of the previous one, select its end point.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends polyline input.    You can also end polyline input by clicking on the stop button  
on the command tool bar or by pressing the Esc key.

See the section on Specifying Positions for more information on entering the polyline end points.
See the section on Line Properties for more information on the different types of polylines which
can be drawn.    See the Polylines section for more information on polylines.



Display Page
To turn the display of the printer/plotter page on and off in the drawing area, choose the 
Options/Display page command.    If this item is checked, the page is displayed.    It it is not 
checked, the page is not displayed.

See also:
Page Setup



Closed Polyline
To Draw a closed polyline, all you have to do is choose the Draw/Polyline/Closed polyline 
command from the pull down menu.    The prompt area will display:

Select first end point of closed polyline

After specifying the first end point, a line is drawn from that point to the current cursor position 
as you move the cursor.    This represents the first segment of the polyline which would be added 
to the drawing if the current cursor position was used for the second end point.    The prompt area
changes to:

Select next end point of polyline

When the second end point is specified, a polyline segment with the designated start and end 
points is added to the drawing.    It is displayed using the current line properties in effect.    The 
program continues to prompt you for the end point of the next segment of the polyline.    If you 
wish to add another segment which starts at the end of the previous one, select its end point.

Choosing another operation from the main menu (except those on the Snaps, Options, or Help 
menus) ends polyline input.    You can also end polyline input by clicking on the stop button  
on the command tool bar or by pressing the Esc key.    When the Closed polyline command is 
ended, a segment is drawn from the last point entered to the first point entered, closing the 
polyline.

See the section on Specifying Positions for more information on entering the polyline end points.
See the section on Line Properties for more information on the different types of polylines which
can be drawn.    See the Polylines section for more information on polylines.



Display DXF Elements
A DXF file can contain certain entities which cannot be accurately displayed in GammaCAD.    
These entities are displayed with this symbol .    To turn the display of these DXF elements on 
and off in the drawing area, choose the Options/Display DXF elements command.    If this item is
checked, the elements are displayed.    If it is not checked, these elements are not displayed.    You
will have to redraw the drawing using the View/Redraw command to see the effects of this 
command.

See also:
Importing DXF Files



Monochrome Print/Plot
The Options/Program configuration/Monochrome print/plot command allows you to force all 
drawings to be plotted as monochrome.    When this option is checked and a drawing is 
printed/plotted, all colors of the drawing elements are changed to black.    The only exception to 
this is white drawing elements are still plotted as white.    The color of the drawing elements on 
the display, and as stored in the drawing file, are not changed.    This mapping of all colors to 
black is effective only during the print/plot process.    If the Monochrome print/plot option is not 
checked, the colors of the drawing elements are not changed and are sent to the printer/plotter 
with the same values as when they are drawn on the display.

Why would you want to use this option?    Some print/plot drivers will map colors to the closest 
color which they can display.    This can lead to some colors being mapped to white and thus they
are not printed on the page.    If you are having trouble with drawing elements not showing up on 
the printout and you know they fall on the page, try checking the Monochrome print/plot option 
and reprinting the drawing.

See also:
Program Configuration



Grid Dot Size
The Options/Program configuration/Grid dot size command allows you to specify the size of the
grid dots when a grid is displayed.    When you choose this command, the following dialog is 
displayed:

Grid Dot Size Dialog

This value must be greater than or equal to zero.    The larger the value, the larger the grid dot.    
When the desired value has been entered, press the OK button.    To exit this dialog without 
changing the current value, press the Cancel button.

See also:
Program Configuration
Grid Snap Parameters
Grid Density



Grid Density
The Options/Program configuration/Grid density command allows you to specify the maximum 
number of the grid dots displayed in the drawing area.    This prevents the program from 
displaying the grid when the number of dots it would have to draw on the screen exceeds the 
input maximum.    The value which is best for you depends on how fast the grid dots are drawn 
on your system and at what point the grid dots tend to obscure the drawing area.    When the 
value is exceeded, the following message is displayed: Grid too dense to display.    This only 
affects the display of the grid.    You can still use the grid snap feature even though the grid is not 
visible.    If at some later point the grid can be displayed (e.g. you zoom in on the drawing), it 
will be redrawn.    To keep from getting this message, either increase the grid density value using 
this command or turn the grid display off.

When the Grid density command is chosen, the following dialog is displayed:

Grid Density Dialog

This value must be greater than or equal to zero.    The larger the value, the more grid dots the 
program will display in a grid.    When the desired value has been entered, press the OK button.    
To exit this dialog without changing the current value, press the Cancel button.    Do not enter a 
value of zero to turn off the grid display, instead turn the grid display off using the Options/Grid 
snap parameters command.

See also:
Program Configuration
Grid Snap Parameters
Grid Dot Size



Changing the Layer of a Drawing Element
When you select the Edit/Change command and then choose the Layer option in the change 
dialog, the following dialog is displayed.

Change Layer Dialog

This dialog is used to change the layer for all the elements which are currently selected in the 
drawing.    Double click on the layer on which you wish the selected elements to be placed.    You
may also click on the layer once and press the OK button.    Use the up and down arrow keys to 
select it with the keyboard and then press the Enter key.    Press the Cancel button to end this 
command without changing the layer for the currently selected drawing elements.



Prototype Drawing
Whenever GammaCAD creates a new drawing, it looks in the GammaCAD directory for a file 
with the name GCAD.GC1.    This is the prototype drawing.    If the file is found, it is opened and
read like any other drawing.    The properties in this drawing will thus be set in the new drawing.  
The name of the drawing after choosing the File/New command will still be Untitled whether or 
not a prototype drawing exists.    When you save it, you will be prompted for a drawing name.

The prototype drawing can be used to set a default value for any property which is saved with a 
drawing.    All of the properties on the Options menu are set with the exception of the Program 
Configuration options.    Printer and page setup are also set by the prototype drawing.

To create or modify a prototype drawing, select File/New from the menu.    If any previous 
prototype drawing has been created, its defaults will be used for the new drawing.    Next, use the
Options, File/Print/plot setup and File/Page setup commands to set the desired values for the 
prototype drawing.    Then save the drawing to the file GCAD.GC1 in the GammaCAD directory.
The next time you create a new drawing, the new prototype drawing properties will be used.



Selecting Elements One at a Time
The Edit/Select/Select one command allows you to select elements one at a time.    When you 
choose this command, the prompt area displays:

Select a single element

The cursor is changed to a box cursor.    Move the cursor so the element you wish to select passes
through the box cursor and click the left mouse button.    The first drawing element the program 
finds is selected.    This option only selects one element, so if two or more elements pass through 
the box cursor, only one is selected.    This is usually the one which was drawn first.    The 
program continues to prompt you to select another element.    You can select another element or 
end the command by clicking on the stop button  on the command tool bar.    Element snaps 
do not affect the selection points you pick with this command.

The current selection mode also affects this command.    This means this command can be used 
to add elements to the current selection one at a time.    It can also be used to remove elements 
from the current selection one at a time.    See the section on selecting drawing elements for a 
description of setting the selection mode.

This command can be used to select one element when two elements fall directly on top of each 
other.    For example, suppose you drew a series of 3 connected line segments.    At some later 
point you decide you would prefer they were a polyline.    You draw a polyline directly on top of 
the line segments using the end element snap.    Then you remove the lines by checking the 
Edit/Select/Add option and choosing the Edit/Select/Select one command.    Next, select each line
segment.    Since you are using the Select one command which selects only the first element 
drawn, the line segments and not the polyline are selected.    When all segments are selected, 
press the delete key to delete them.    The program erases the line segments which also erases the 
polyline.    Choose View/Redraw to see the polyline is still there.

See also:
Selecting Drawing Elements



Line Properties Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Line color
Line type
Line width



Page Setup Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Fit drawing to page
Print/plot scale
Position drawing on page



Text Properties Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Text font
Text height
Text angle
Text orientation
Text justification



Point Properties Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Point color
Point type
Point size



Fill / Hatch Properties Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Fill / Hatch color
Fill / Hatch type



Dimension Properties Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Dimension arrow scale
Dimension offset



Program Configuration Menu
Move the cursor over the desired menu item and click the left mouse button or select the item 
from the list below.

Selection set color
Cursor increment
Arc/circle step factor
Monochrome print/plot
Grid dot size
Grid density



Legal Stuff
COPYRIGHT
© Copyright 1992, 1993, 1994, 1995 by Gamma Software.    All rights reserved.
This software and accompanying documentation are protected by copyright law and international
treaty.

TRADEMARKS
GammaCAD, GammaCAD PRO and Gamma Software are trademarks of Gamma Software.
CompuServe is a registered trademark of CompuServe, Inc.
Microsoft and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft 
Corporation.
True Type is a registered trademark of Apple Computer, Inc.
Arial and Times New Roman are registered trademarks of the Monotype Corporation PLC.
AutoCAD is a registered trademark and DXF a trademark of Autodesk, Inc.
Other brands or products are trdemarks or registered trademarks of their respective holders and 
should be treated as such.



Graphical Index
To use this index move the cursor over the part of the program window in which you are 
interested.    If the cursor changes to a pointing hand, then you can click the left mouse button 
and move to that topic within this document.



This is the prompt or message area where the program prompts you for input or displays 
messages.



This is the status area where the program displays the current xy coordinates and the line, point, 
text and fill properties for the current layer.



Help Tutorials
This command brings up the tutorials sub menu.



Help Examples
This command brings up the examples sub menu.






